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Preface

Welcome to the JD Edwards EnterpriseOne Tools IBM WebSphere Portal for Windows 
Guide.

Audience
This guide is intended for system administrators and technical consultants who are 
responsible for configuring portal content.

This guide assumes you have a working knowledge of the following:

• Setting up and configuring portals.

• The principles and customary practices of your business area.

• Computer desktop application usage and terminology.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are 
hearing impaired.

Related Documents
You can access related documents from the JD Edwards EnterpriseOne Release 
Documentation Overview pages on My Oracle Support. Access the main 
documentation overview page by searching for the document ID, which is 876932.1, or 
by using this link:

https://support.oracle.com/CSP/main/article?cmd=show&type=NOT&id
=876932.1

To navigate to this page from the My Oracle Support home page, click the Knowledge 
tab, and then click the Tools and Training menu, JD Edwards EnterpriseOne, Welcome 
Center, Release Information Overview.

https://support.oracle.com/CSP/main/article?cmd=show&type=NOT&id=876932.1 
https://support.oracle.com/CSP/main/article?cmd=show&type=NOT&id=876932.1 
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This guide contains references to server configuration settings that JD Edwards 
EnterpriseOne stores in configuration files (such as jde.ini, jas.ini, jdbj.ini, 
jdelog.properties, and so on). Beginning with the JD Edwards EnterpriseOne Tools 
Release 8.97, it is highly recommended that you only access and manage these settings 
for the supported server types using the Server Manager program. See the Server 
Manager Guide.

Conventions
The following text conventions are used in this document:

Convention Meaning

Bold Indicates field values.

Italics Indicates emphasis and JD Edwards EnterpriseOne or other 
book-length publication titles.

Monospace Indicates a JD Edwards EnterpriseOne program, other code 
example, or URL.
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1Overview

This document describes the process of installing and configuring WebSphere Portal 
Server v7.0. Before beginning the installation, verify that your environment meets the 
requirements by referring to the Minimum Technical Requirements document for 
Collaborative Portal 7.0, which is referenced in this section of this guide: Minimum 
Technical Requirements.

This document steps the installer through the installation, upgrade, and configuration 
of the WebSphere Portal Server environment and its related components. The 
document includes sections on databases transfer, security, and LDAP. WebSphere 
Portal v7.0 includes an install wizard that eases the entire installation process.

WebSphere Portal v7.0 includes an install wizard to make the overall installation 
process friendlier. The installation wizard can be used for post installation processes 
such as database transfer, disable and enable security and configure LDAP server.
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2Installing the WebSphere Portal Server

This chapter discusses:

■ Section 2.1, "Prerequisites"

■ Section 2.2, "Preparing the Microsoft Windows Operating System"

■ Section 2.3, "Retrieving WebSphere Portal 7.0 Software from Oracle JD Edwards 
Update Center"

■ Section 2.4, "Installing the Portal Server"

2.1 Prerequisites
The following sections discuss the prerequisites for installing the Websphere portal 
server.

2.1.1 Minimum Technical Requirements
Before you install Portal v7.0, you must first install WebSphere Application Server 7.0 
and the latest supported fix pack listed in the JD Edwards EnterpriseOne HTML Web 
Server Minimum Technical Requirements (MTRs). These MTRs are available on My 
Oracle Support in document ID 705409.1 and can be accessed at this link:

https://metalink3.oracle.com/od/faces/secure/km/DocumentDisplay.
jspx?id=705409.1

2.1.2 Installing WebSphere Application Server 7.0
To install WebSphere Application Server 7.0, refer to Chapter 3: Installing and 
Configuring WebSphere Application Server 7.0 in the JD Edwards EnterpriseOne 
HTML Web Server Reference Guide for Microsoft Windows-Based Systems and 
WebSphere Application Server 7.0. This document is available on My Oracle Support 
in document ID 705495.1 and can be accessed at this link:

https://metalink3-dr.oracle.com/od/faces/secure/km/DocumentDispl
ay.jspx?id=705495.1

If you are using same single physical machine for both the Portal and the HTML  
Server, you cannot install the JD Edwards EnterpriseOne HTML Web Server (also 
called JAS) to the same profile as that of Portal. By default, WebSphere Portal v7.0 
creates a separate profile called wp_profile.

2.1.3 References
IBM product documentation for Portal v7.0:



Preparing the Microsoft Windows Operating System

2-2 JD Edwards EnterpriseOne Tools IBM WebSphere Portal for Microsoft Windows Guide

http://www.ibm.com/developerworks/websphere/zones/portal/proddoc
/index.html

http://www-10.lotus.com/ldd/portalwiki.nsf/xpViewCategories.xsp?
lookupName=IBM%20WebSphere%20Portal%207%20Product%20Documentatio
n&SessionID=CWFHNIG8CY

IBM WebSphere Application Server 7.0 Info Center:

http://publib.boulder.ibm.com/infocenter/wasinfo/v7r0/index.jsp

IBM Portal v7.0 Hardware and Software Requirements:

http://www-01.ibm.com/support/docview.wss?uid=swg27007791

2.2 Preparing the Microsoft Windows Operating System
Use these steps to prepare your Microsoft Windows operating system for the 
installation of Portal 7.0 components:

1. Check that the system logon user ID you will use during installation has the 
following permissions and rights:

■ The user ID must already exist prior to installation.

■ The user ID must belong to the Administrators group.

2. Perform these steps to determine if a user account is a member of the 
Administrators group:

a. Click Start > Programs > Administrative Tools > Computer Management.

b. Expand Local Users and Groups and select Groups.

c. Open the Administrators group to see what members belong to it.

d. Add the user to the Administrators group if necessary.

3. Consider these recommendations when installing to avoid excessively long path 
names:

■ Specify short cell and node names; do not use names longer than 5 characters. 
For example, you might use scell instead of stonemillNode01cell.

■ Ensure there are no special characters in the node and/or cell names as they 
are known to cause problems during install.

■ Name WAR files with less than 21 characters. If necessary, modify the file 
name before installing.

■ Refer to the following tech note for additional information: WKSP0016E - 
'Filename is too long error' in Microsoft Windows..

4. If you are installing on a server with a firewall enabled, disable the firewall before 
installing. If you do not disable the firewall and the installation program detects it, 
a warning message might be displayed during the installation.

Note: If you exceed the 259 maximum character length, you may 
receive one of these error messages during configuration or in the 
wpinstalllog.txt file: · The input line is too long. · The syntax of the 
command is incorrect. · The filename is too long.
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2.3 Retrieving WebSphere Portal 7.0 Software from Oracle JD Edwards 
Update Center

To retrieve WebSphere Portal 7.0 Software from the Oracle JD Edwards Update Center:

1. Log on to EnterpriseOne Update Center:

http://updatecenter.oracle.com

2. Select “EnterpriseOne Technology Foundation” type.

3. Select the platform.

4. Select and download the following files for WebSphere Portal 7.0 installation (The 
files are based on platform type):

5. Unzip the .par files that you downloaded from the Update Center to a temporary 
location. When unzipped, they files will appear as follows:

■ wps70-windows.zip.001

■ wps70-windows.zip.002

Extracting WebSphere Portal 7.0 Software 
To  extract WebSphere Portal 7.0 Software:

1. Move both wps70-windows.zip* files to a “WPS70” folder.

2. Extract  wps70-windows.zip.001 using the 7zip product.

3. The unzip process will process both files.

2.4 Installing the Portal Server
To begin the installation

Name Description

IBM_WPS_7.0_Install_Guide_Win_1-2.par WebSphere Portal 7.0 Install and Quick Start 
Guide 1/2

IBM_WPS_7.0_Install_Guide_Win_2-2.par WebSphere Portal 7.0 Install and Quick Start 
Guide 2/2

Note: Uses the regular Microsoft Windows unzip command to 
extract the files.
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1. From either the Setup CD or directory, you can use various methods to launch the 
installer, as shown in this table (it is recommended to use Graphical user interface 
for installation):

2. On the installation type screen, select IBM WebSphere Portal Extend. Click Next 
button.

Installation Method Command and Description

Graphical user interface install

Console mode install -console

Silent install install -options "path_to_file\response_filename"

where path_to_file is the full path to the response file, and

where response_filename is the name of the file.

A sample install response file (installresponse.txt) and a sample 
uninstall response file (uninstallresponse.txt) are located in the 
root directory of the Setup CD.

Important: Do not place the response file in a path that contains 
a space and do not put a space in the file name.

Note: If the installation program does not detect a WebSphere 
Application Server instance that you know exists, exit the installation 
program and re-run it using command line options to specify the 
WebSphere Application Server instance  location.

For example: 

install -W was.undetectedWas="\my\WAS\location" 

Upon execution, by default the installer creates a separate profile 
called wp_profile. This profile is used to host the Portal contents. 
Therefore, you should not install Portal into an existing profile with 
other applications installed.
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3. Accept the license terms and Click the Next button.
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4. Select Base as the install type and click Next button.
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5. Select "To existing WebSphere application server installation" and click Next 
button.
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The installer detects your WebSphere Application Server 7.0 installation. For 
example:

X:\IBM7\WebSphere\AppServer

6. On the WAS location screen, choose the WAS installation into which you want to 
install the Portal.
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If you have multiple installations of WebSphere, the program may detect more 
than one WebSphere location.

7. With the desired location selected, click the Next button. This is the directory 
where the wp_profile and PortalServer directories will be created.
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8. On the instance properties screen, complete these fields:

Field Description

Node name Enter a unique Node name for this installation of WebSphere 
Portal and Lotus Web Content Management.

The Node name is used to identify the server. Having a unique 
node name is important when configuring a federated, production 
environment.

Do not use names that contain special characters (i.e _ 
underscore..etc.).

Host name Enter the fully-qualified Host name for this installation of 
WebSphere Portal and Lotus Web Content Management. The Host 
name must include the fully-qualified domain name (for example, 
hostname.example.com). Do not use a local host or a loopback 
address
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9. Click the Next button.

10. On the security screen for the administration user ID and password, WebSphere 
Portal enables security by default. It is not possible and/or recommended to 
disable security. Complete these fields:

Field Description

Administrative User ID Enter the user ID that you assign for the Portal 
administrator. For example:

wpsadmin

This user is used for Stopping Services after the 
Portal installation is completed. It is not related to 
any user IDs used to access the operating system.

Administrative Password Enter the password for the Administrative User 
defined in the previous field.

Confirm Password Confirm the password you entered in the previous 
field.
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11. Select the checkbox to configure the WebSphere_Portal server to run as a windows 
service and Click the Next button.
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12. On the summary screen, review your selections for the Portal installation.
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13. Click the Next button to start the installation process.

As the installer begins, it creates a default portal profile called wp_profile.

14. When the installation completes, locate and open the wps.properties file from this 
directory:

X:\IBM\WebSphere\PortalServer

15. Verify the version= parameter in the wps.properties file specifies the updated 
Portal version: 7.0.0.0
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16. After the installation completes successfully following screen will be displayed. 
Uncheck both the boxes and click Finish to complete the installation. Note the 
WebSphere Portal and Web Content Management and WebSphere Application 
Server URL's from the screen.

17. Accessing the WPS and WCM link brings up the following screen:
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18. Clicking on Login brings up the login portlet. Login with the credentials provided 
during the installation (i.e with wpsadmin user credentials).

19. After successful login the Administrative page is displayed as shown above.
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This completes the installation of WebSphere Portal 7.
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3Database Configuration for WebSphere
Portal

This chapter discusses the database configuration for the Websphere portal.

By default, IBM WebSphere Portal v7.0 installs and uses an Apache Derby database. 
Installing with Apache Derby lets you quickly get WebSphere Portal installed and 
running in a proof-of-concept environment. Before using the product extensively, you 
should visit the IBM Information Center for Portal v7.0 to learn the advantages and 
disadvantages of using Apache Derby and determine how transferring to another 
database affects the capacity and scalability of a production environment. Please refer 
to the following link from IBM: 
https://www-304.ibm.com/support/docview.wss?uid=swg27019558#Data
bases_C-worksWith

The Apache Derby database that is installed by default is not intended for use in a 
production environment or for authoring Web content. Derby does not support 
clustered environments, enabling security in a database-only mode, or vertical cloned 
environments in which multiple application servers are configured on a single server. 
Use one of the other supported databases in a production environment or when 
authoring Web content because they are better able to handle large amounts of data 
and can be tuned for performance.

When you choose to transfer data to another supported database such as Oracle or 
SQL Server or IBM DB2 for LUW (Linux, UNIX, Windows) or DB2 for IBM i, perform 
the database transfer before you use the portal extensively. Large amounts of data in 
the databases can cause the database transfer to fail if your Java heap size is not large 
enough. Because information is added to the databases as you use the Portal, perform 
the database transfer as soon as it is practical to avoid problems in a production 
environment.

Data can be transferred from a Derby database, but cannot be transferred to a Derby 
database. If you are transferring from a database other than the default database, you 
will need to edit the wkplc.properties, wkplc_dbdomain.properties and wkplc_
dbtype.properties files to update the source and target database information.

You can install the database server on the same system as WebSphere Portal, or you 
can install the database server on a different, also referred to as a remote system.

Using a remote database can have performance benefits. When you are deploying a 
large scale environment, you can dedicate a server specifically to your database. As 
more users are accessing the portal, the portal application becomes database intensive. 
Database activity can take up CPU utilization and disk I/O time. You can increase 
capacity by separating the database from the server that the Portal is running on 
increases capacity.
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If you install the database server on a remote system, you may be required to install 
database client software on the WebSphere Portal system so the Portal can 
communicate with the remote database server.

Documentation in this section is taken directly from the IBM WebSphere Portal v7.0 
Infocenter.
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4Configuring IBM WebSphere Portal Server
v7.0 to use Oracle Database

This chapter discusses configuring the IBM Websphere portal server v7.0 to use the 
Oracle database. It contains the following topics:

■ Section 4.1, "Before You Begin"

■ Section 4.2, "Working with Properties Files"

■ Section 4.3, "Creating the Oracle Database for IBM WebSphere Portal Server v7.0"

■ Section 4.4, "Oracle Database Setup Considerations"

4.1 Before You Begin
Before beginning the database configuration, verify that a supported version of Oracle 
Database software is installed. Refer to the Minimum Technical Requirements for this 
information. In addition, we strongly recommend you visit the IBM WebSphere Portal 
Version v7.0 Information Center and review the "Configuring WebSphere Portal to use 
a database" section:  
http://www-10.lotus.com/ldd/portalwiki.nsf/dx/Windows_
standalone_Configuring_WebSphere_Portal_to_use_a_database_wp7.

For advanced configurations, refer to the IBM WebSphere Portal Version v7.0 
Information Center.

4.2 Working with Properties Files
You must modify the approriate properties files before transferring your data from the 
default database to the Oracle or Oracle RAC database. Working with properties files:

■ Multiple databases can be used to hold information for applications such as 
Feedback and LikeMinds. For example, you could use the following property 
values:

– release.DbName=reldb

– jcr.DbName=jcrdb

– feedback.DbName=fdbkdb

– likeminds.DbName=lmdb

– community.DbName=commdb

– customization.DbName=custdb

■ If you are using a remote database, enter the values for the remote server.
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■ Regardless of the operating system, use a forward slash (/) instead of a backslash 
(\) in the property files for file system paths.

■ There might be additional database properties other than those listed here. Only 
change the properties within this task and skip all other properties.

■ The recommended value listed for each property represents the specific 
information that is required to configure WebSphere Portal to your target 
database.

■ Depending on which database domain has to be configured, replace dbdomain 
with:

– release

– customization

– community

– jcr

– feedback

– likeminds

■ The values for at least one of the following properties must be unique for the 
release, customization, community, and JCR domains:

– dbdomain.DbName

– dbdomain.DbUrl

– dbdomain.DbSchema

■ If you use the same values for all three properties across the release, 
customization, community, and JCR domains, the database-transfer task fails due 
to ambiguous database object names.

■ If DbUser, DbUrl, and DbPassword are not the same across domains, the value for 
DataSourceName must differ from the DataSourceName of the other domains. In 
other words, this value must be unique for the database domain.

When doing a single database, single user, and multi schema database transfer, there 
can be only one user for each domain (release, community, customization, JCR, 
Feedback, and LikeMinds), and the schema for each database must be different. The 
user must be a superuser or DBA and must have authority over all other schemas for 
the transfer to work.

1. Locate the following files and create a backup copy of each before changing any 
values:

■ wp_profile_root/ConfigEngine/properties/wkplc.properties

■ wp_profile_root/ConfigEngine/properties/wkplc_dbdomain.properties

■ wp_profile_root/ConfigEngine/properties/wkplc_dbtype.properties

Default values are listed in these files. Unless otherwise noted, all values are of 
type alphanumeric text string. Print out the steps below for reference before 
modifying the properties files. Make sure to enter the appropriate values for each 
instance of each property. In wkplc_dbdomain.properties, most properties are 
repeated for each domain.

2. Use a text editor to open the properties file wkplc_dbdomain.properties and 
modify the values to correspond to your environment.

a. For dbdomain.DbType, type oracle.
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b. For dbdomain.DbName, type the name of the WebSphere Portal domain 
database.

c. For dbdomain.DbSchema, type the schema name of the database domain.

d. For dbdomain.DataSourceName, type the name of the data source that 
WebSphere Portal uses to communicate with its databases.

Do not use the following reserved words:

– releaseDS

– communityDS

–  customizationDS 

– jcrDS

–  lmdbDS

–  feedback

e. For dbdomain.DbUrl, type the database URL used to access the WebSphere 
Portal database with JDBC. The value must conform to the JDBC URL syntax 
specified by the database.

f. For dbdomain.DbUser, type the user ID for the database configuration user.

g. For dbdomain.DbPassword, type the password for the database configuration 
user.

h. For dbdomain.DbConfigRoleName, type the name of the group for database 
configuration users. Database rights are granted to this group instead of 
individuals. The user specified for dbdomain.DbUser must be assigned to this 
group.

i. Optional: For dbdomain.DbRuntimeUser, type the user ID of the database 
user that should be used by WebSphere Portal to connect to the database at 
runtime. If no value is specified for this setting, the database configuration 
user will be used to connect to the databases at runtime.

If dbdomain.DbRuntimeUser is specified, you must set 
dbdomain.DbRuntimePassword to be the password of the runtime database 
user.

j. For dbdomain.DbRuntimeRoleName, type the name of the group for database 
runtime users. Database rights are granted to this group instead of 

Note: This value is also the database element in the dbdomain.DbUrl 
property.

Note: Review your target database management system 
documentation to define a valid schema name. Some database 
management systems have schema name restrictions that you need to 
understand.

Note: The database element of this value should match the value of 
DbName.
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individuals. The user specified for dbdomain.DbRuntimeUser must be 
assigned to this group.

k. Optional: For dbdomain.DBA.DbUser, type the database administrator user ID 
for privileged access operations during database creation. If you do not need 
this parameter, you can either accept the default value or leave blank.

l. Optional: For dbdomain.DBA.DbPassword, type the database administrator 
password for privileged access operations during database creation. If you do 
not need this parameter, you can either accept the default value or leave blank.

m. For dbdomain.DbHome, type the root location for the database.

3. Save and close the file.

4. Update the following properties in the file wkplc_dbtype.properties.

■ For oracle.DbDriver, type the name of the Oracle JDBC driver class.

■ For oracle.DbLibrary, type the directory and name of the .jar file that contains 
the JDBC driver class.

■ For oracle.JdbcProviderName, type the name of the JDBC provider that 
WebSphere Portal uses to communicate with its databases.

5. Save and close the file.

6. Update the WasPassword value in the wkplc.properties file. This value is the 
password for the WebSphere Application Server security authentication used in 
your environment.

7. Save and close the file.

4.3 Creating the Oracle Database for IBM WebSphere Portal Server v7.0
1. Launch Database Configuration Assistant (dbca), click Next:

Note: This value is used to specify the location to create the 
tablespaces.
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2. Select create database, click next:
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3. Select General Purpose or Transaction Processing, click next:
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4. Provide the SID, click next:
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5. Select Configure with EnterpriseManager, click next:
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6. Provide account and password details, click next:
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7. Configure the storage options, and then click next:
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8. Configure file locations, click Next:
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9. Configure recovery options, click next:
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10. Do Not install sample schemas, click next:
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11. Configure UNICODE Character Set:
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12. Configure Connection Mode, click next:
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13. Configure Security settings, click next:
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14. Configure maintenance task, click next:
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15. Review storage information, click next:
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16. Review information, click finish:
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17. Once the installation completes review the installation summary information:
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18. From sqlplus command line perform the following select query:

SQL> select * from NLS_DATABASE_PARAMETERS;
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4.4 Oracle Database Setup Considerations
Listed below are some important considerations before setting up Oracle databases to 
work with WebSphere Portal. 

For information about creating databases, refer to the Oracle product documentation. 
For information on the recommended database architecture and the databases you will 
need to create, see the Planning for Oracle topic. Be sure that all databases to be used 
with WebSphere Portal are created as UNICODE character set databases. 

If you are using Oracle 10g databases, you must also obtain a copy of the ojdbc6.jar file 
from the Oracle JDBC driver download site, copy it to the WebSphere Portal machine, 
and update the wkplc_dbtype.properties file with oracle.DbLibrary=(the path to the 
local ojdbc6.jar). If you are using Oracle 11g databases, you must also copy the 
ojdbc6.jar file from the Oracle server to the WebSphere Portal machine and update the 
wkplc_dbtype.properties file with oracle.DbLibrary=(the path to the local ojdbc6.jar). 
The typical location is the oracle_home/sqldeveloper/jdbc/lib directory. Record the 
copy location on your local machine for future reference. 

When creating Oracle databases for use with WebSphere Portal, you should consider 
the following information:

■ The Oracle databases must be created manually before configuring WebSphere 
Portal.

■ All databases must be created using UNICODE Database and National character 
sets such as UTF8, AL32UTF8, or AL16UTF16.

■ It is recommended that all databases to be used with WebSphere Portal are 
configured in Dedicated Server Mode.
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■ Determine if your Oracle server will be remote or local to the WebSphere Portal 
installation.

■ After installing the database software for WebSphere Portal, you will need to set 
the buffer pools allocated to the Oracle database in order for WebSphere Portal to 
communicate with the Java Content Repository database. Use the following 
recommended values as a guide. Refer to the Oracle product documentation for 
information on how to set the buffer pools. Recommended initial buffer pool sizes:

db_block_size = 8192 bytes

db_cache_size = 307,200 bytes

db_files = 1024 files

log_buffer = 65536 bytes

open_cursors = 1500 cursors

pga_aggregate_target = 204,800 bytes

pre_page_sga = true

processes = 300 processes

shared_pool_size = 204,800 bytes

■ Raise the number of parallel servers as appropriate. For example, if you have more 
than 875 parallel servers, you should set the parallel_max_serversto 1200.

■ The Oracle parameter CURSOR_SHARING allows similar SQL Statements to be 
shared when possible, which prevents parsing and establishing a new execution 
plan. The execution plan is used by Oracle to gather the data needed to satisfy a 
request. There are two options for CURSOR_SHARING, which are as follows:

■ FORCE

When you select this option, Oracle uses the same execution plan for all SQLs 
that are similar in value even if the values are different. When you use this 
option, the execution plan may not provide optimum performance. For 
example, similar SQLs with different values may behave differently when 
executed running the same plan.

■ EXACT

When you select this option, Oracle only shares the same execution plan for 
SQLs that are identical and use the same values. This option removes the risk 
of a SQL statement being executed when optimum performance conditions do 
not exist.

■ WebSphere Portal supports both options. Regardless of the option selected, portlet 
applications should not be affected. Contact your database administrator for 
further assistance on these options.

Refer to the following instructions for creating tablespaces:

1. In the database directory, create the data directory data and the index 
directoryindex.

Note: If you are using IBM Java Content Repository, the open_
cursors value may need to be increased based on the table count in the 
Java Content Repository schema.
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2. Create tablespaces using the following commands as examples:

a. Substitute the values of your environment for the following variables:

– &jcrdb. is the name of the database you created to store user data.

– &dbpath. is the directory where you created the database; the default path 
is /oracle/oradata.

b. Ensure that the '.' is included in the variables when you substitute the values 
of your environment with these variables. 

create tablespace ICMLFQ32 datafile '&dbpath./&jcrdb./data/&jcrdb._
ICMLFQ32_01.dbf' size 300M reuse autoextend on next 10M maxsizeUNLIMITED 
extent management local autoallocate;
 
create tablespace ICMLNF32 datafile '&dbpath./&jcrdb./data/&jcrdb._
ICMLNF32_01.dbf' size 25M reuse autoextend on next 10M maxsizeUNLIMITED 
extent management local autoallocate;
 
create tablespace ICMVFQ04 datafile '&dbpath./&jcrdb./data/&jcrdb._
ICMVFQ04_01.dbf' size 25M reuse autoextend on next 10M maxsizeUNLIMITED 
extent management local autoallocate;
 
create tablespace ICMSFQ04 datafile '&dbpath./&jcrdb./data/&jcrdb._
ICMSFQ04_01.dbf' size 150M reuse autoextend on next 10M maxsizeUNLIMITED 
extent management local autoallocate;
 
create tablespace ICMLSNDX datafile '&dbpath./&jcrdb./index/&jcrdb._
ICMLSNDX_01.dbf' size 10M reuse autoextend on next 10M maxsizeUNLIMITED 
extent management local autoallocate;

c. Set the size, autoextend, and maxsize values according to your environment. 
For example, you may want to change the maxsize to a set value rather than 
UNLIMITED.

d. Consult your Database Administrator for specific guidance about creating 
tablespaces for your environment.

e. Refer to the Oracle command reference for more information about using the 
create tablespaces command.

This topic provides instructions on automatically setting up your database using the 
ConfigEngine task to create users, grant permissions, and create Java Content Repository table 
spaces.

1. On the database server, make sure the subfolders your_oracle_instance/data and 
your_oracle_instance/index exist. If this folder hierarchy does not exist, create it 
manually before you run the setup-database task.

The setup-database task requires these folders to create table spaces. If these 
folders do not exist, the setup-database task will fail. Note: The setup-database 
task creates the table spaces, index spaces, and the database users as specified in 
the properties files.

2. Change to the directory wp_profile_root/ConfigEngine

3. To create the database users, type the following command:

Important: You must use the same table space names listed in the 
commands. The table space names cannot be customized or modified.
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./ConfigEngine.sh setup-database -DWasPassword=password

This section provides information on how to manually transfer data from the default database 
to the Oracle database you have installed and set up. Follow these steps to transfer WebSphere 
Portal, and Java Content Repository databases to Oracle. As an alternative to the manual 
database transfer procedure described here, you can use the configuration wizard to complete 
the database transfer task. 

Before you begin, ensure that the following prerequisites are met:

■ Supported database software is installed.

■ Databases and users are set up.

■ Property files are modified.

1. Open a command prompt and change to the directory wp_profile_
root\\ConfigEngine.

2. Enter the ./ConfigEngine.sh validate-database -DWasPassword=password 
command to validate configuration properties.

3. From the same command prompt as the previous steps, change to the directory 
wp_profile_root\\bin.

4. Stop both the server1 and WebSphere_Portal servers:

■ ./stopServer.bat server1 -username admin_userid -password 
admin_password

■ ./stopServer.bat WebSphere_Portal -username admin_userid 
-password admin_password

5. Transfer the database:

a. Change to the directory wp_profile_root\\ConfigEngine.

b. Enter the following command:

./ConfigEngine.sh database-transfer -DWasPassword=password

Note: The task setup-database assigns the minimum database 
privileges to the database configuration and runtime database users.

Tips: If you are transferring from Oracle or Oracle RAC, the open_
cursors setting should be set to 1500 by default. However, you might 
need to increase this value based on the table count in the Java 
Content Repository schema.

When doing a single database, single user, and multi schema database 
transfer, there can be only one user for each domain (release, 
community, customization, JCR, Feedback, and LikeMinds), and the 
schema for each database must be different. The user must be a 
superuser or DBA and must have authority over all other schemas for 
the transfer to work.

Tip: Add the -DTransferDomainList parameter to the above 
validating task to specify the domains you want to validate; for 
example: -DTransferDomainList=jcr. If you want to validate all 
domains, you do not need to specify this parameter on the command 
line.
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c. After running the task, a message is added to the following log file for you to 
verify the task ran successfully: wp_profile_
root\\ConfigEngine\\log\\ConfigTrace.log

d. If the configuration fails, verify the values in the wkplc.properties, wkplc_
dbdomain.properties, and wkplc_dbtype.properties files and then repeat this 
step.

6. Optional: If you specified a runtime database user for the 
dbdomain.DbRuntimeUser parameter, that user must have sufficient database 
user privileges. To grant the database user privileges, choose either the manual 
steps or the command line steps:

7. Complete these steps to manually grant database user privileges:

a. Copy the appropriate template files to a work directory. Choose one of the 
following template files:

– createRuntimeRoleForDifferentSchema.sql if the name of the database 
user and the schema name are not the same.

– createRuntimeRoleForSameSchema.sql if the name of the database user 
and the schema name are the same.

– JCR database domain: For the JCR database domain, you must also copy 
grantExtendedPermissionsToRuntimeRole.sql.

b. Locate these files in the following directories:

PortalServer_
root\\base\\wp.db.impl\\config\\templates\\setupdb\\dbms\\domain 
PortalServer_
root\\pzn\\prereq.pzn\\config\\templates\\setupdb\\dbms\\domain

c. Replace all placeholder values with the values as defined in wkplc_
dbdomain.properties. Placeholder values are surrounded by the character @.

d. Run these statements.

Complete these steps to grant database user privileges with the ConfigEngine 
task:

Ensure the database administrator user ID is specified for 
domain.DBA.DbUser in wp_profile_
root\\ConfigEngine\\properties\\wkplc_dbdomain.properties. For 
example, domain.DBA.DbUser=dbadmin.

e. Run the following task: ./ConfigEngine.sh grant-runtime-db-user-privileges 
-DTransferDomainList=comma_separated_list_of_domains

8. After transferring the database tables, run the dbms_stats.gather_schema_stats 
command to update the database statistics.

For example:

Note: To select specific database domains to transfer, modify the 
-DTransferDomainList specified in the command to include only the 
domains that you want to transfer. For example, to transfer only the 
JCR domain you can enter the following command:

 ./ConfigEngine.sh database-transfer 
-DTransferDomainList=jcr -DWasPassword=password
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SQL> execute dbms_stats.gather_schema_stats(ownname=> 'jcr', 
cascade=> TRUE);

9. Run the ./ConfigEngine.sh create-jcr-jms-resources-post-dbxfer 
-DWasPassword=password command to create JMS resources in the new database.

10. Change to the directory wp_profile_root\\bin.

11. Start the Administrative server (server1) and WebSphere Portal server.

Note: Regardless of the method used to transfer data (configuration 
wizard or the steps in this topic), you must run this task to create JMS 
resources.
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5Configuring IBM WebSphere Portal v7.0 to
use DB2 for IBM i Database

This chapter discusses configuring the IBM Websphere portal v7.0 to use the DB2 for 
IBM i database. It contains the following topics:

■ Section 5.1, "Before You Begin"

■ Section 5.2, "Working with Properties Files"

■ Section 5.3, "Creating and Assigning Users to Groups"

■ Section 5.4, "Using ConfigEngine Tasks to Create Databases for a Local DB2 for 
IBM i Installation"

■ Section 5.5, "Automatically Creating Users, Granting Permissions, and Creating 
Java Content Repository Table Spaces"

■ Section 5.6, "Transferring WebSphere Portal and Java Content Repository 
Databases to DB2 for IBM i"

■ Section 5.7, "Updating the Database Configuration to Support Large Files (Web 
Content Management Only)"

■ Section 5.8, "Configuring JDBC Driver for WebSphere Portal"

5.1 Before You Begin
Before beginning the database configuration, verify that a supported version of DB2 
for IBM i Database software is installed. Refer to the Minimum Technical 
Requirements for this information. In addition, it is strongly recommended that you 
visit the IBM WebSphere Portal Version v7.0 Information Center and review the 
"Configuring WebSphere Portal to use a database" section:

http://www-10.lotus.com/ldd/portalwiki.nsf/dx/Windows_
standalone_Configuring_WebSphere_Portal_to_use_a_database_wp7 

For advanced configurations, refer to the IBM WebSphere Portal Version v7.0 
Information Center.

View information on installing DB2 for IBM i for use with WebSphere Portal 
Before you begin:

■ When you install DB2 for IBM i using the DB2 for IBM i installation program, it 
automatically creates a DB2 for IBM i administrative user with the correct 
operating system rights.


http://www-10.lotus.com/ldd/portalwiki.nsf/dx/Windows_standalone_Configuring_WebSphere_Portal_to_use_a_database_wp7

http://www-10.lotus.com/ldd/portalwiki.nsf/dx/Windows_standalone_Configuring_WebSphere_Portal_to_use_a_database_wp7
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■ Ensure that you have enough disk space for the DB2 for IBM i instance home 
directory to be able to create the required databases.

1. If you are using the JDBC driver in type 2 mode, configure your DB2 for IBM i 
client with the following commands.

If you are using a remote database, complete this step separately from the 
WebSphere Portal installation.

■ db2 update dbm cfg using tp_mon_name WAS

■ db2 update dbm cfg using spm_name hostname, where hostname is the host 
name of WebSphere Portal.

Because the default for spm_name is the hostname itself, specifying the hostname 
parameter is optional. If your hostname is more than eight characters, use empty 
double quotes (" "). For example, db2 update dbm cfg using spm_name " ".

2. Before installing DB2 for IBM i, log in with a user ID that has administrative 
authority.

This user should have the following specifications:

■ Belong to the local Administrator group

■ Act as part of the operating system

■ Have permissions to create a token object

■ Have permissions to replace a process level token

To edit user rights:

■ For the first two specifications: Click Start -> Programs -> Administrative 
Tools -> Computer Management -> Local Users and Groups.

■ For the last four specifications: Click Start -> Programs -> Administrative 
Tools -> Local Security Policy. Then, click Local Policies -> User Rights 
Assignment.

3. To install DB2 for IBM i or the DB2 for IBM i client and the required fix pack, 
follow the instructions that are provided with the DB2 for IBM i documentation.

4. If DB2 for IBM i is installed on another system than WebSphere Portal, perform the 
following instructions:

■ For JDBC Type 2 drivers only: The appropriate DB2 for IBM i client must be 
installed on the same system as WebSphere Portal and have the same name as 
the server profile name.

■ For JDBC Type 4 drivers only: Copy the driver jar files to the Portal server. It is 
recommended that you place these driver files within the wp_profile_
rootdirectory; for example:

wp_profile_root/PortalServer/dbdrivers/db2jcc4.jar 

wp_profile_root/PortalServer/dbdrivers/db2jcc_license_
cu.jar

5.2 Working with Properties Files
You must modify the approriate properties files before transferring your data from the 
default database to the DB2 for IBM i database. 
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■ Multiple databases can be used to hold information for applications such as 
Feedback and LikeMinds. For example, you could use the following property 
values:

■ release.DbName=reldb

■ jcr.DbName=jcrdb

■ feedback.DbName=fdbkdb

■ likeminds.DbName=lmdb

■ community.DbName=commdb

■ customization.DbName=custdb

■ If you are using a remote database, enter the values for the remote server.

■ Regardless of the operating system, use a forward slash (/) instead of a backslash 
(\) in the property files for file system paths.

■ There might be additional database properties other than those listed here. Only 
change the properties within this task and skip all other properties.

■ Some values, shown here in italics, might need to be modified to your specific 
environment.

■ The recommended value listed for each property represents the specific 
information that is required to configure WebSphere Portal to your target 
database.

■ Depending on which database domain has to be configured, replace dbdomain 
with:

■ release

■ customization

■ community

■ jcr

■ feedback

■ likeminds

■ The values for at least one of the following properties must be unique for the 
release, customization, community, and JCR domains:

■ dbdomain.DbName

■ dbdomain.DbUrl

■ dbdomain.DbSchema

■ If you use the same values for all three properties across the release, 
customization, community, and JCR domains, the database-transfer task fails due 
to ambiguous database object names.

■ If DbUser, DbUrl, and DbPassword are not the same across domains, the value for 
DataSourceName must differ from the DataSourceName of the other domains. In 
other words, this value must be unique for the database domain.

1. Locate the following files and create a backup copy of each before changing any 
values:

■ wp_profile_root/ConfigEngine/properties/wkplc.properties

■ wp_profile_root/ConfigEngine/properties/wkplc_dbdomain.properties
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■ wp_profile_root/ConfigEngine/properties/wkplc_dbtype.properties

■ If you are transferring from a database other than Derby: wp_profile_
root/ConfigEngine/properties/wkplc_sourceDb.properties

Default values are listed in these files. Unless otherwise noted, all values are of 
type alphanumeric text string. Print out the steps below for reference before 
modifying the properties files. Make sure to enter the appropriate values for each 
instance of each property. In wkplc_dbdomain.properties, most properties are 
repeated for each domain.

2. Use a text editor to open the properties file wkplc_dbdomain.properties and 
modify the values to correspond to your environment.

a. For dbdomain.DbType, type db2.

b. For dbdomain.DbName, type the name of the WebSphere Portal domain 
database.

c. For dbdomain.DbSchema, type the schema name of the database domain.

d. For dbdomain.DataSourceName, type the name of the data source that 
WebSphere Portal uses to communicate with its databases.

Do not use the following reserved words:

– releaseDS

– communityDS

– customizationDS

– jcrDSx

– feedback

jcrDS

e. For dbdomain.DbUrl, type the database URL used to access the WebSphere 
Portal database with JDBC. The value must conform to the JDBC URL syntax 
specified by the database.

f. For dbdomain.DbUser, type the user ID for the database configuration user.

g. For dbdomain.DbPassword, type the password for the database configuration 
user.

Note: This value is also the database element in the dbdomain.DbUrl 
property.

Note: Review your target database management system 
documentation to define a valid schema name. Some database 
management systems have schema name restrictions that you need to 
understand.

Note: The database element of this value should match the value of 
DbName.
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h. For dbdomain.DbConfigRoleName, type the name of the group for database 
configuration users. Database rights are granted to this group instead of 
individuals. The user specified for dbdomain.DbUser must be assigned to this 
group.

i. Optional: For dbdomain.DbRuntimeUser, type the user ID of the database 
user that should be used by WebSphere Portal to connect to the database at 
runtime. If no value is specified for this setting, the database configuration 
user will be used to connect to the databases at runtime.

j. If dbdomain.DbRuntimeUser is specified, you must set 
dbdomain.DbRuntimePassword to be the password of the runtime database 
user.

k. For dbdomain.DbRuntimeRoleName, type the name of the group for database 
runtime users. Database rights are granted to this group instead of 
individuals. The user specified for dbdomain.DbRuntimeUser must be 
assigned to this group.

l. Optional: For dbdomain.DBA.DbUser, type the database administrator user ID 
for privileged access operations during database creation. If you do not need 
this parameter, you can either accept the default value or leave blank.

m. Optional: For dbdomain.DBA.DbPassword, type the database administrator 
password for privileged access operations during database creation. If you do 
not need this parameter, you can either accept the default value or leave blank.

3. Save and close the file.

4. Update the following properties in the file wkplc_dbtype.properties.

a. For db2.DbDriver, type the name of the JDBC driver class.

b. For db2.DbLibrary, type the directory and name of the .zip or .jar file that 
contains the JDBC driver class.

c. For db2.JdbcProviderName, type the name of the JDBC provider that 
WebSphere Portal uses to communicate with its databases.

5. Save and close the file.

6. Update the WasPassword value in the wkplc.properties file. This value is the 
password for the WebSphere Application Server security authentication used in 
your environment.

7. Save and close the file.

5.3 Creating and Assigning Users to Groups
Before transferring the databases to DB2 for IBM i, you must first create the users and 
groups you have specified in wkplc_dbdomain.properties and assign the users to their 
corresponding group. The user and group names must comply with both the database 
management system software requirements and WebSphere Portal requirements.

1. Create a user for dbdomain.DbUser. If you have provided a value in the wkplc_
dbdomain.properties file indicating that a runtime user should be used to connect 
to the database at runtime, create a user for dbdomain.DbRuntimeUser. When 
creating these users, use the same user ids and passwords entered in the wkplc_
dbdomain.properties file.
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2. Create a group for dbdomain.DbConfigRoleName. If you have provided a value in 
the wkplc_dbdomain.properties file for dbdomain.DbRuntimeRoleName, create a 
group for dbdomain.DbRuntimeRoleName.

3. Assign the created user for dbdomain.DbUser to the created group for 
dbdomain.DbConfigRoleName.

4. If dbdomain.DbRuntimeUser is specified, assign the created user for 
dbdomain.DbRuntimeUser to the created group for 
dbdomain.DbRuntimeRoleName.

5.4 Using ConfigEngine Tasks to Create Databases for a Local DB2 for 
IBM i Installation

This section provides information on using ConfigEngine tasks to create databases 
when using a local DB2 for IBM i installation. If you are using a remote DB2 for IBM i 
installation, you must create your databases manually and cannot create databases 
using the ConfigEngine task. 

Before you begin, ensure that the following prerequisites are met:

■ The database management system software is installed.

■ To create a database, you must be a DB2 for IBM i System Administrator with 
sufficient database privileges (SYSADM or at a minimum SYSCTRL).

1. Log in as a DB2 for IBM i instance system authority. For example, you can log in as 
db2inst1 as the DB2 for IBM i instance owner.

2. Change to the directory wp_profile_root/ConfigEngine

3. To create the databases, type the following command:

./ConfigEngine.sh create-database -DWasPassword=password

5.5 Automatically Creating Users, Granting Permissions, and Creating 
Java Content Repository Table Spaces

This topic provides instructions on automatically setting up your database using the 
ConfigEngine task to create users, grant permissions, and create Java Content 
Repository table spaces. 

You must create your DB2 for IBM i databases before running the configuration task in 
this topic. 

As an alternative to automatically setting up the database, you can manually set up 
your database by referring to the link in the related tasks section of this topic.

1. Change to the directory wp_profile_root/ConfigEngine

2. To create the database users, type the following command:

./ConfigEngine.sh setup-database -DWasPassword=password

Note: The task setup-database assigns the minimum database 
privileges to the database configuration and runtime database users.
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5.6 Transferring WebSphere Portal and Java Content Repository 
Databases to DB2 for IBM i

View information on manually transferring data to the DB2 for IBM i database you 
have installed and set up. Follow these steps to transfer WebSphere Portal and Java 
Content Repository databases to DB2 for IBM i. As an alternative to the manual 
database transfer procedure that this topic describes, you can use the configuration 
wizard to complete the database transfer task. However, you cannot specify all settings 
through the configuration wizard. For this reason, you must specify the required 
settings in the appropriate property files before transferring the database with the 
configuration wizard.

 Tips:

1. If you are running a type 2 connection, edit the db2cli.ini file that resides on the 
local system, where WebSphere Portal is installed, before you transfer data.

a. Locate the file C:\Program Files\IBM\SQLLIB\db2cli.ini.

b. Add the following lines to the end of the file:

Editing db2cli.ini:

If a section named [COMMON] already exists in the file, extend that section 
by adding the following lines. Otherwise, add a [COMMON] section to the 
file. Leave an empty line after ReturnAliases=0.

[COMMON]

DYNAMIC=1

ReturnAliases=0

2. Open a command prompt and change to the directory wp_profile_
root\ConfigEngine.

3. Enter the ./ConfigEngine.sh validate-database -DWasPassword=password 
command to validate configuration properties.

Tips: ■To run these tasks as a non-root user, you must first run the 
task shown -R non-root_user WebSphereDir.

■ If you are transferring from Oracle or Oracle RAC, the open_
cursors setting should be set to 1500 by default. However, you 
might need to increase this value based on the table count in the 
Java Content Repository schema.

■ Be sure that DB2 for IBM i is started by checking the service. If 
attempts to restart result in a logon failure message, then go to the 
DB2 properties and reenter the password.

Important: The database transfer becomes unresponsive at task 
action-process-constraints if you do not complete these steps.

Tip: Add the -DTransferDomainList parameter to the above 
validating task to specify the domains you want to validate; for 
example: -DTransferDomainList=jcr. If you want to validate all 
domains, you do not need to specify this parameter on the command 
line.
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4. From the same command prompt as the previous steps, change to the directory 
wp_profile_root\bin.

5. Stop both the server1 and WebSphere_Portal servers:

■ ./stopServer.bat server1 -username admin_userid -password 
admin_password

■ ./stopServer.bat WebSphere_Portal -username admin_userid 
-password admin_password

6. Transfer the database:

a. Change to the directory wp_profile_root\ConfigEngine.

b. Enter the following command:

./ConfigEngine.sh database-transfer -DWasPassword=password

c. After running the task, a message is added to the following log file for you to 
verify the task ran successfully:

wp_profile_root\ConfigEngine\log\ConfigTrace.log

If the configuration fails, verify the values in the wkplc.properties, wkplc_
dbdomain.properties, and wkplc_dbtype.properties files and then repeat this 
step.

7. Optional: If you specified a runtime database user for the 
dbdomain.DbRuntimeUser parameter, that user must have sufficient database 
user privileges. To grant the database user privileges, choose either the manual 
steps or the command line steps:

Complete these steps to manually grant database user privileges:

a. Copy the appropriate template files to a work directory. Choose one of the 
following template files:

– createRuntimeRoleForDifferentSchema.sql if the name of the database 
user and the schema name are not the same.

– createRuntimeRoleForSameSchema.sql if the name of the database user 
and the schema name are the same.

Note:

■ To select specific database domains to transfer, modify the 
-DTransferDomainList specified in the command to include only 
the domains that you want to transfer. For example, to transfer 
only the JCR domain you can enter the following command: 

./ConfigEngine.sh database-transfer 
-DTransferDomainList=jcr -DWasPassword=password

■ If you have been storing data in Apache® Derby for a long time, 
database transfer could fail with OutOfMemory exceptions. If 
database transfer fails, add the following property to the 
command in this step:

 ./ConfigEngine.sh database-transfer 
-DDbtJavaMaxMemory=1536M -DWasPassword=password
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JCR database domain: For the JCR database domain, you must also copy 
grantExtendedPermissionsToRuntimeRole.sql.

b. Locate these files in the following directories:

PortalServer_
root\base\wp.db.impl\config\templates\setupdb\dbms\domain 

PortalServer_
root\pzn\prereq.pzn\config\templates\setupdb\dbms\domain

c. Replace all placeholder values with the values as defined in wkplc_
dbdomain.properties. Placeholder values are surrounded by the character @.

d. Run these statements.

Complete these steps to grant database user privileges with the ConfigEngine task:

a. Ensure the database administrator user ID is specified for 
domain.DBA.DbUser inwp_profile_root\ConfigEngine\properties\wkplc_
dbdomain.properties. For example, domain.DBA.DbUser=dbadmin.

b. Run the following task: 

./ConfigEngine.sh grant-runtime-db-user-privileges 
-DTransferDomainList=comma_separated_list_of_domains

8. After transferring the database tables, perform a reorg check to improve 
performance. Perform this step for each database alias in the property file.

a. Connect to a database with the following command:

db2 connect to database_alias user db2admin_userid using 
password

b. After it is connected, run the following command from the DB2 for IBM i 
prompt:

db2 reorgchk update statistics on table all > xyz.out

c. Look in the reorg column for entries marked with a star or asterisk * in the file 
xyz.out.

For each line with *, note the tablename and run the following command for 
each tablename:

db2 reorg table tablename

d. After you have run the reorg command for each tablename, run the following 
commands:

db2 terminate db2rbind database_name -l db2rbind.out -u 
db2_admin -p password

e. The output file db2rbind.out is only created when there is an error for the 
db2rbind command.

9. Run the ./ConfigEngine.sh create-jcr-jms-resources-post-dbxfer 
-DWasPassword=password command to create JMS resources in the new database.

Note: Additional options might be required if additional security has 
been installed. Refer to DB2 for IBM i Universal Database commands 
by example for links to the command reference.
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10. Change to the directory wp_profile_root\bin.

11. Start the Administrative Server (server1) and WebSphere Portal server.

5.7 Updating the Database Configuration to Support Large Files (Web 
Content Management Only)

If you are using Web Content Management, you must update the database 
configuration to support large files. Do this by setting thefullyMaterializeLobData 
property in the WebSphere Application Server administrative console. 

1. Log into the WebSphere Application Server administrative console.

2. Click Resources -> JDBC -> Data sources.

3. Select all scopes (the default setting) or select a specific cell, node, or node/server.

Select the scope that corresponds to your instance of WebSphere Portal. 

The view refreshes.

4. Select the name of the data source that is defined in wkplc_dbdomain.properties 
for the JCR database domain.

The default data source is wpdbDS.

5. Click Custom properties.

6. Ensure that the fullyMaterializeLobData property is set to false.

5.8 Configuring JDBC Driver for WebSphere Portal
WebSphere Portal requires the use of either the IBM® DB2 Legacy JDBC driver in type 
2 mode or the IBM DB2 Universal JDBC driver in type 4 mode when connecting to 
DB2 for IBM i. 

Before you begin, ensure that the following conditions are met:

■ The WebSphere Portal database has been successfully transferred to DB2 for IBM i 
using the database-transfer configuration task.

■ The files wkplc_dbdomain.properties and wkplc_dbtype.properties have been 
modified to set the correct values for the DB2 drivers that you are switching to:

– In the file wkplc_dbdomain.properties set each <Domain>.DbUrl property 
using the following formats:

# db2 (type 2): { jdbc:db2:wpsdb }

# db2 (type 4): { 
jdbc:db2://<YourDatabaseServer>:50000/wpsdb:returnAlias=0; 
}

Note: Regardless of the method used to transfer data (configuration 
wizard or the steps in this topic), you must run this task to create JMS 
resources.

Note: You only need to perform these steps if you are using Web 
Content Management.
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– In the file wkplc_dbtype.properties set the db2.DbLibrary property using the 
following format:

# For DB2 Type 2 driver use <SQLLIB>/java/db2jcc4.jar

# For DB2 Type 4 driver use 
<SQLLIB>/java/db2jcc4.jar;<SQLLIB>/java/db2jcc_license_
cu.jar

– In the file wkplc_dbtype.properties set the db2.DbDriver property using the 
following format:

# For DB2 Type 2 driver use com.ibm.db2.jcc.DB2Driver

# For DB2 Type 4 driver use com.ibm.db2.jcc.DB2Driver
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6Configuring IBM WebSphere Portal Server
v7.0 to use SQL Server 200x Database

This chapter discusses configuring the IBM Websphere portal v7.0 to use the SQL 
Server 200x database. It contains the following topics:

■ Section 6.1, "Before You Begin"

■ Section 6.2, "Working with Properties Files"

■ Section 6.3, "Alternative Method for Creating Databases"

■ Section 6.4, "Using the ConfigEngine Task to Automatically Set Up a Database"

■ Section 6.5, "Manually Transferring Data from the Default Database to the SQL 
Server Database"

6.1 Before You Begin
Before beginning the database configuration, verify that a supported version of 
Microsoft SQL Server Database software is installed. Refer to the Minimum Technical 
Requirements for this information. In addition, we strongly recommend you visit the 
IBM WebSphere Portal Version v7.0 Information Center and review the "Configuring 
WebSphere Portal to use a database" section:

http://www-10.lotus.com/ldd/portalwiki.nsf/dx/Windows_
standalone_Configuring_WebSphere_Portal_to_use_a_database_wp7 

For advanced configurations, refer to the IBM WebSphere Portal Version v7.0 
Information Center.

View the steps to install SQL Server for use with WebSphere Portal. Before you begin 
this task, complete the following prerequisites:

■ You should have completed reviewing the Planning for SQL Server topic.

■ You must install SQL Server separately from WebSphere Portal.

You can obtain the Microsoft SQL Server JDBC Driver from Microsoft. See the 
Microsoft SQL Server product documentation for installation details (sqljdbc4.jar)

This section provides instructions for installing SQL Server for use with IBM® 
WebSphere® Application Server and WebSphere Portal. These steps are the same for 
both the DataDirect and Microsoft drivers unless noted.

Note: The driver must be a JDBC 4.0 compliant driver.


http://www-10.lotus.com/ldd/portalwiki.nsf/dx/Windows_standalone_Configuring_WebSphere_Portal_to_use_a_database_wp7

http://www-10.lotus.com/ldd/portalwiki.nsf/dx/Windows_standalone_Configuring_WebSphere_Portal_to_use_a_database_wp7
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1. Install SQL Server and all required patches.

2. Select the Mixed Mode (Windows Authentication and SQL Server Authentication) 
authentication mode for this installation.

3. In the SQL Server Setup panel, Components to Install, select the following 
component, which is required services for WebSphere Portal:

SQL Server Database Services

4. Complete the installation using SQL Server as per documentation.

5. Enable TCP/IP connectivity in the SQL Server Configuration Manager.

6. Installing Microsoft SQL Server JDBC drivers:

a. Download and install the Microsoft SQL Server JDBC driver; see Microsoft 
Download Center for information.

b. Start the database server.

c. Start the Microsoft SQL Server Management Studio and connect to the local 
database engine as the system administrator, sa.

d. Select File -> Open -> File and select xa_install.sql from the subdirectory of the 
downloaded and extracted JDBC driver.

e. Execute the script by selecting Query -> Execute.

7. Start SQL Server.

6.2 Working with Properties Files
You must modify the approriate properties files before transferring your data from the 
default database to the SQL database.

■ Multiple databases can be used to hold information for applications such as 
Feedback and LikeMinds. For example, you could use the following property 
values:

■ release.DbName=reldb

■ jcr.DbName=jcrdb

■ feedback.DbName=fdbkdb

■ likeminds.DbName=lmdb

■ community.DbName=commdb

■ customization.DbName=custdb

■ If you are using a remote database, enter the values for the remote server.

Important: Mixed Mode authentication allows either a Windows 
user or an SQL Server user, or both, to log in to the SQL Server; 
however, WebSphere Portal requires the user to be an SQL Server user.

Note: Any warnings that appear in the messages section of the 
application window that say that stored procedures cannot be found 
can be safely ignored.
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■ Regardless of the operating system, use a forward slash (/) instead of a backslash 
(\) in the property files for file system paths.

■ There might be additional database properties other than those listed here. Only 
change the properties within this task and skip all other properties.

■ Some values, shown here in italics, might need to be modified to your specific 
environment.

■ The recommended value listed for each property represents the specific 
information that is required to configure WebSphere Portal to your target 
database.

■ Depending on which database domain has to be configured, replace dbdomain 
with:

■ release

■ customization

■ community

■ jcr

■ feedback

■ likeminds

■ The values for at least one of the following properties must be unique for the 
release, customization, community, and JCR domains:

■ dbdomain.DbName

■ dbdomain.DbUrl

■ dbdomain.DbSchema

■ If you use the same values for all three properties across the release, 
customization, community, and JCR domains, the database-transfer task fails due 
to ambiguous database object names.

■ If DbUser, DbUrl, and DbPassword are not the same across domains, the value for 
DataSourceName must differ from the DataSourceName of the other domains. In 
other words, this value must be unique for the database domain.

1. Locate the following files and create a backup copy of each before changing any 
values:

■ wp_profile_root/ConfigEngine/properties/wkplc.properties

■ wp_profile_root/ConfigEngine/properties/wkplc_dbdomain.properties

■ wp_profile_root/ConfigEngine/properties/wkplc_dbtype.properties

■ If you are transferring from a database other than Derby: wp_profile_
root/ConfigEngine/properties/wkplc_sourceDb.properties

Default values are listed in these files. Unless otherwise noted, all values are of 
type alphanumeric text string. Print out the steps below for reference before 
modifying the properties files. Make sure to enter the appropriate values for each 
instance of each property. In wkplc_dbdomain.properties, most properties are 
repeated for each domain.

2. Use a text editor to open the properties file wkplc_dbdomain.properties and 
modify the values to correspond to your environment.

a. For dbdomain.DbType, type sqlserver2005.
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b. For dbdomain.DbName, type the name of the WebSphere Portal domain 
database.

c. For dbdomain.DbSchema, type the schema name of the database domain.

d. For dbdomain.DataSourceName, type the name of the data source that 
WebSphere Portal uses to communicate with its databases.

Do not use the following reserved words:

releaseDS

 communityDS 

customizationDS 

jcrDS 

lmdbDS 

feedback

e. For dbdomain.DbUrl, type the database URL used to access the WebSphere 
Portal database with JDBC. The value must conform to the JDBC URL syntax 
specified by the database.

f. For dbdomain.DbUser, type the user ID for the database configuration user.

g. For dbdomain.DbPassword, type the password for the database configuration 
user.

h. For dbdomain.DbConfigRoleName, type the name of the group for database 
configuration users. Database rights are granted to this group instead of 
individuals. The user specified for dbdomain.DbUser must be assigned to this 
group.

i. Optional: For dbdomain.DbRuntimeUser, type the user ID of the database 
user that should be used by WebSphere Portal to connect to the database at 
runtime. If no value is specified for this setting, the database configuration 
user will be used to connect to the databases at runtime.

j. If dbdomain.DbRuntimeUser is specified, you must set 
dbdomain.DbRuntimePassword to be the password of the runtime database 
user.

k. For dbdomain.DbRuntimeRoleName, type the name of the group for database 
runtime users. Database rights are granted to this group instead of 

Note: This value is also the database element in the dbdomain.DbUrl 
property.

Note: Review your target database management system 
documentation to define a valid schema name. Some database 
management systems have schema name restrictions that you need to 
understand.

Note: The database element of this value should match the value of 
DbName.
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individuals. The user specified for dbdomain.DbRuntimeUser must be 
assigned to this group.

l. Optional: For dbdomain.DBA.DbUser, type the database administrator user ID 
for privileged access operations during database creation. If you do not need 
this parameter, you can either accept the default value or leave blank.

m. Optional: For dbdomain.DBA.DbPassword, type the database administrator 
password for privileged access operations during database creation. If you do 
not need this parameter, you can either accept the default value or leave blank.

n. For dbdomain.DbHome, type the root location for the database.

This path must use two backslashes (\\) instead of a forward slash (/).

o. For dbdomain.AdminUrl, type the sqlserver URL without a database attached.

This value is used to connect to the server for database administration 
operations.

p. For dbdomain.DbHostName, type the hostname of the database.

3. Save and close the file.

4. Update the following properties in the file wkplc_dbtype.properties.

a. For sqlserver2005.DbDriver, type the name of the JDBC driver class.

b. For sqlserver2005.DbLibrary, type the directory and name of the .zip or .jar file 
that contains the JDBC driver class.

c. For sqlserver2005.JdbcProviderName, type the name of the JDBC provider 
that WebSphere Portal uses to communicate with its databases.

d. For sqlserver2005.DbConnectionPoolDataSource, type the name of the 
implementation class of the connection pool data source.

5. Save and close the file.

6. Update the WasPassword value in the wkplc.properties file. This value is the 
password for the WebSphere Application Server security authentication used in 
your environment.

7. Save and close the file.

6.3 Alternative Method for Creating Databases
Use this alternative method for creating databases if you have problems running the 
create-database task that is documented for setting up a remote SQL Server database 
on Windows for a stand-alone production server. 

Before you begin, you must create the databases. 

1. Expand the nodes to see Databases.

2. Right-click on Databases to see New database.

3. Enter the database name. For information on the recommended database 
architecture and the databases you will need to create, see Planning for SQL Server

Note: This value is the location to store the database files locally.
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4. On the Options page, select Collation Name from the drop-down list that matches 
your environment. Set the collation to case-sensitive. For example, on an English 
system: SQL_Latin1_General_CP1_CS_AS

5. Click OK to save the database changes

6.4 Using the ConfigEngine Task to Automatically Set Up a Database
This topic provides instructions on automatically setting up your database using the 
ConfigEngine task. As an alternative to automatically setting up the database, you can 
manually create users and grant privileges. 

Before you begin, ensure that the database management system software is installed.

1. Change to the directory wp_profile_root/ConfigEngine

2. To create the databases, type the following command:

./ConfigEngine.sh create-database -DWasPassword=password

3. To create the database users, type the following command:

./ConfigEngine.sh setup-database -DWasPassword=password

4. Start the Microsoft SQL Server Management Studio.

5. Expand the Databases folder.

6. Right-click on the JCR database and select Properties.

7. Click Files.

8. Locate the database log row and click the details button (...) located immediately 
after the Autogrowth field.

9. Check the Enable Autogrowth check box and set the autogrowth properties as 
needed. When using Restricted File Growth, set the value to at least 100 MB.

10. Click OK to save your changes to the Change Autogrowth screen.

11. Click OK to save your changes to the Database Properties screen.

12. Exit the Microsoft SQL Server Management Studio.

Note: For LikeMinds, CI is the default setting; however, CS can also 
be used.

Note: The task setup-database assigns the minimum database 
privileges to the database configuration and runtime database users.

Important: After setting up your databases, enable the autogrowth 
feature for the log associated with the JCR database. This will ensure 
that uploading large files (approximately 100 MB or larger) to Web 
Content Management works properly.
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6.5 Manually Transferring Data from the Default Database to the SQL 
Server Database

This section provides information on how to manually transfer data from the default 
database to the SQL Server database. Follow these steps to transfer WebSphere Portal 
and Java Content Repository databases to SQL Server. As an alternative to the manual 
database transfer procedure described here, you can use the configuration wizard to 
complete the database transfer task. 

Before you begin, make sure that the following prerequisites are met:

■ Supported database software is installed.

■ Databases and users are set up.

■ Property files are modified.

1. Open a command prompt and change to the directory wp_profile_
root\\ConfigEngine.

2. Enter the ./ConfigEngine.sh validate-database -DWasPassword=password 
command to validate configuration properties.

Tip: Add the -DTransferDomainList parameter to the above validating task to 
specify the domains you want to validate; for example: -DTransferDomainList=jcr. 
If you want to validate all domains, you do not need to specify this parameter on 
the command line.

3. From the same command prompt as the previous steps, change to the directory 
wp_profile_root\\bin.

4. Stop both the server1 and WebSphere_Portal servers:

■ ./stopServer.bat server1 -username admin_userid -password 
admin_password

■ ./stopServer.bat WebSphere_Portal -username admin_userid 
-password admin_password

5. Transfer the database:

a. Change to the directory wp_profile_root\\ConfigEngine.

b. Enter the following command:

./ConfigEngine.sh database-transfer -DWasPassword=password

Tip: If you are transferring from Oracle or Oracle RAC, the open_
cursors setting should be set to 1500 by default. However, you might 
need to increase this value based on the table count in the Java 
Content Repository schema.

Note: To select specific database domains to transfer, modify the 
-DTransferDomainList specified in the command to include only the 
domains that you want to transfer. For example, to transfer only the 
JCR domain you can enter the following command:

 ./ConfigEngine.sh database-transfer 
-DTransferDomainList=jcr -DWasPassword=password
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c. After running the task, a message is added to the following log file for you to 
verify the task ran successfully:

wp_profile_root\\ConfigEngine\\log\\ConfigTrace.log

If the configuration fails, verify the values in the wkplc.properties, wkplc_
dbdomain.properties, and wkplc_dbtype.properties files and then repeat this 
step.

6. Optional: If you specified a runtime database user for the 
dbdomain.DbRuntimeUser parameter, that user must have sufficient database 
user privileges. To grant the database user privileges, choose either the manual 
steps or the command line steps:

Complete these steps to manually grant database user privileges:

a. Copy the appropriate template files to a work directory. Choose one of the 
following template files:

– createRuntimeRoleForDifferentSchema.sql if the name of the database 
user and the schema name are not the same.

– createRuntimeRoleForSameSchema.sql if the name of the database user 
and the schema name are the same.

JCR database domain: For the JCR database domain, you must also copy 
grantExtendedPermissionsToRuntimeRole.sql.

b. Locate these files in the following directories:

PortalServer_
root\\base\\wp.db.impl\\config\\templates\\setupdb\\dbms\\
domain 

PortalServer_
root\\pzn\\prereq.pzn\\config\\templates\\setupdb\\dbms\\d
omain

c. Replace all placeholder values with the values as defined in wkplc_
dbdomain.properties. Placeholder values are surrounded by the character @.

d. Run these statements.

Complete these steps to grant database user privileges with the ConfigEngine task:

a. Ensure the database administrator user ID is specified for 
domain.DBA.DbUser inwp_profile_
root\\ConfigEngine\\properties\\wkplc_dbdomain.properties. For 
example, domain.DBA.DbUser=dbadmin.

b. Run the following task: ./ConfigEngine.sh grant-runtime-db-user-privileges 
-DTransferDomainList=comma_separated_list_of_domains

7. Run the ./ConfigEngine.sh create-jcr-jms-resources-post-dbxfer 
-DWasPassword=password command to create JMS resources in the new database.

8. Change to the directory wp_profile_root\\bin.

9. Start the Administrative Server (server1) and WebSphere Portal server.

Note: Regardless of the method used to transfer data (configuration 
wizard or the steps in this topic), you must run this task to create JMS 
resources.
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10. Update the SQL Server 2005 statistics for Portal, and JCR databases by opening 
SQL Server Management Studio, selecting New Query, and running the following 
query: 

use db_name exec sp_updatestats @resample='resample';



Manually Transferring Data from the Default Database to the SQL Server Database

6-10 JD Edwards EnterpriseOne Tools IBM WebSphere Portal for Microsoft Windows Guide



7

Verifying Database Connections 7-1

7Verifying Database Connections

This section provides information on verifying database connections.

7.1 Verifying Database Connections
After you configure IBM® WebSphere® Portal to work with your database, test the 
database connection to ensure that it operates correctly. Then verify that all database 
transactions work properly within the WebSphere Portal environment. For example, 
all portal pages should display without HTTP 404 errors, and there should be no 
database layer-related exceptions in the SystemOut.log and SystemErr.log files. 

You can verify the database connection using IBM WebSphere Application Server or 
by opening WebSphere Portal in a browser.

To verify that the WebSphere Portal application server is running by using WebSphere 
Application Server, complete these steps:

1. Open the WebSphere Application Server administrative console by entering the 
following address in a browser:

http://hostname.example.com:10001/ibm/console 

where hostname.example.com is the fully qualified host name of the machine 
where WebSphere Portal is running and 10042 is the default transport port that is 
created by WebSphere Application Server.

2. Log into the administrative console.

3. Click Resources, JDBC, JDBC Providers.

4. Select all scopes (the default setting) or select a specific cell, node, or node/server.

Select the scope that corresponds to your instance of WebSphere Portal. 

The view refreshes.

5. Select the name of the data source that is defined in wkplc_dbdomain.properties.

The default data source is wpdbDS.

6. Select the name of the JDBC provider that is specified in wkplc_dbtype.properties.

The default JDBC provider is wpdbJDBC_dbtype, where dbtype is replaced by the 
value that matches your environment.

7. Click Test Connection to verify the database connection.

If configuration parameters have been changed, you might need to restart 
WebSphere Application Server for the test to complete.
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To verify that the WebSphere Portal application server is running by opening 
WebSphere Portal in a browser, enter the following URL in a supported browser:

http://hostname.example.com:10039/wps/portal

where hostname.example.com is the fully qualified host name of the machine,  where 
WebSphere Portal is running and 10039 is the default transport port that is created by 
WebSphere Application Server.
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8Configuring the Microsoft Active Directory
for Portal

This chapter contains the following topics:

■ Section 8.1, "Installing Microsoft Active Directory for Microsoft Windows 200x"

■ Section 8.2, "Working with LDAP Attributes"

■ Section 8.3, "Configuring LDAP Server for Dynamic Group Queries"

■ Section 8.4, "Configuring a Portal to Use LDAP Referrals"

■ Section 8.5, "Enabling Security with the LDAP Directory"

■ Section 8.6, "Configuring an External HTTP Server for WebSphere Portal v7.0"

■ Section 8.7, "Installing the JD Edwards Collaborative Portal"

8.1 Installing Microsoft Active Directory for Microsoft Windows 200x
If you plan to use Active Directory as an LDAP user registry, you must install and set 
up the server so that it will communicate with IBM® WebSphere® Portal. 

8.1.1 Preparing Active Directory
Perform the following steps to install and configure Active Directory:

1. Install required Service Packs.

2. Perform the following steps to install Internet Information Services (IIS), which is 
required to export server certificates and must be installed before installing 
Certificate Services:

a. Open the Control Panel and select Add/Remove Programs.

b. Choose Add/Remove Windows Components.

c. Choose the Internet Information Services (IIS) component and then click Next.

d. Follow the instruction of the Windows Components Wizard. The Windows 
Server CD is needed.

3. Use the following steps to install Certificate Services if you plan on using Active 
Directory over SSL:

a. Open the Control Panel and select Add/Remove Programs.

b. Choose Add/Remove Windows Components.

c. Select Certificate Services and then click Next.
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d. Select Stand-alone root CA and then click Next. You can also choose other 
options depends on you needs.

e. Fill in CA identifying information and then click Next.

f. Follow the instruction of the Windows Components Wizard. The Windows 
Server CD is needed.

Perform the following steps as a guide to create the WebSphere Portal administrative 
user:

1. Create a new user with the Windows administrative tools.

2. Set the password for the new user.

3. Activate the new user with the Windows administrative tools. Set the 
msDS-UserAccountDisabled attribute to false.

Perform the following steps to enable SSL for Active Directory; this step is required to 
set passwords during sign up and user creation:

1. Install an Enterprise Certificate Authority on a Windows 2000 Domain Controller, 
which installs a certificate on a server or install a third-party certificate on the 
Domain Controller.

2. Click Start -> All Programs -> Administrative Tools -> Active Directory Users and 
Computer.

3. In the Active Directory Users and Computers window, right-click on your domain 
name and select Properties.

4. In the Domain Properties dialog box, select the Group Policy tab.

5. Select the Default Domain Policy group policy and then click Edit.

6. Select Windows Settings under Computer Configuration.

7. Select Security Settings and then select Public Key Policies.

8. Select Automatic Certificate Request Settings.

9. Use the wizard to add a policy for Domain Controllers.

8.1.2 LDAP User Registry without SSL
Configure IBM® WebSphere® Portal to use a standalone LDAP user registry to store 
all user account information for authorization. 

If you need to rerun the wp-modify-ldap-security task to change the LDAP 
repositories or because the task failed, you must choose a new name for the realm 
using the standalone.ldap.realm parameter or you can set ignoreDuplicateIDs=true in 
the wklpc.properties file, before rerunning the task. 

Perform the following steps to configure a standalone LDAP user registry: 

Note: There is a 20 character limitation for the user account name.

Note: When these requirements are complete, all domain controllers 
request a certificate and support LDAP over SSL using port 636.
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1. Use a text editor to open the wkplc.properties file, located in the wp_profile_
root\\ConfigEngine\\properties directory.

2. Required: Enter a value for the following required parameters in the 
wkplc.properties file under the Stand-alone security heading:

standalone.ldap.id 

standalone.ldap.host 

standalone.ldap.port 

standalone.ldap.bindDN 

standalone.ldap.bindPassword 

standalone.ldap.ldapServerType 

standalone.ldap.userIdMap 

standalone.ldap.groupIdMap 

standalone.ldap.groupMemberIdMap 

standalone.ldap.userFilter 

standalone.ldap.groupFilter 

standalone.ldap.serverId 

standalone.ldap.serverPassword 

standalone.ldap.realm 

standalone.ldap.primaryAdminId 

standalone.ldap.primaryAdminPassword 

standalone.ldap.primaryPortalAdminId 

standalone.ldap.primaryPortalAdminPassword 

standalone.ldap.primaryPortalAdminGroup 

standalone.ldap.baseDN

3. Required: Enter a value for the following required entity types parameters in the 
wkplc.properties file under the LDAP entity types heading:

standalone.ldap.et.group.objectClasses 

Note: Use the wp_security_xxx.properties helper file, located in the 
wp_profile_root/ConfigEngine/config/helpersdirectory, when 
performing this task to ensure the correct properties are entered. In 
the instructions below, when the step refers to thewkplc.properties 
file, you will use your wp_security_xxx.properties helper file.

Note: See the properties file for specific information about the 
required parameters and for advanced parameters. 

Note: See the properties file for specific information about the 
required parameters and for advanced parameters. 
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standalone.ldap.et.group.objectClassesForCreate 

standalone.ldap.et.group.searchBases 

standalone.ldap.et.personaccount.objectClasses 

standalone.ldap.et.personaccount.objectClassesForCreate 

standalone.ldap.et.personaccount.searchBases

4. Required: Enter a value for the following required group member parameters in 
the wkplc.properties file under the Group member attributes heading:

standalone.ldap.gm.groupMemberName 

standalone.ldap.gm.objectClass 

standalone.ldap.gm.scope 

standalone.ldap.gm.dummyMember

5. Required: Enter a value for the following required relative distinguished name 
(RDN®) parameters in the wkplc.propertiesfile under the Default parent, RDN 
attribute heading:

standalone.ldap.personAccountParent 

standalone.ldap.groupParent 

standalone.ldap.personAccountRdnProperties 

standalone.ldap.groupRdnProperties

6. Save your changes to the wkplc.properties file.

7. Run the ./ConfigEngine.sh validate-standalone-ldap -DWasPassword=password 
task to validate your LDAP server settings.

8. Run the ./ConfigEngine.sh wp-modify-ldap-security -DWasPassword=password 
task, from thewp_profile_root\\ConfigEngine directory, to set the stand-alone 
LDAP user registry.

Note: See the properties file for specific information about the 
required parameters and for advanced parameters.

Note: See the properties file for specific information about the 
required parameters and for advanced parameters.

Attention: If you have not deleted the default file repository, 
WasPassword is the value entered during installation and not a value 
found in your LDAP user registry. 

Note: During the validation task, you may receive the following 
prompt: Add signer to the trust store now? Press y and Enter.
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9. Stop and restart the appropriate servers to propagate the changes. For specific 
instructions, see the following link under Related tasks: Starting and stopping 
servers, deployment managers, and node agents.

10. Run the ./ConfigEngine.sh wp-validate-standalone-ldap-attribute-config 
-DWasPassword=password task, from the wp_profile_root\\ConfigEngine 
directory, to check that all defined attributes are available in the configured LDAP 
user registry.

11. Optional: Run the Member Fixer task to update the member names used by Web 
Content Management with the corresponding members in the LDAP directory. 
This step ensures that access to the Web content libraries for the Intranet and 
Internet Site Templates for the contentAuthors group is correctly mapped to the 
appropriate group in the LDAP directory.

a. Edit the wp_profile_
root\\PortalServer\\wcm\\shared\\app\\config\\wcmservices\\Member
FixerModule.properties file.

b. Add the following lines to the file:

uid=xyzadmin,o=defaultWIMFileBasedRealm -> portal_admin_DN

cn=contentauthors,o=defaultWIMFileBasedRealm -> content_
authors_group_DN

Where portal_admin_DN is the distinguished name of the portal 
administrator and content_authors_group_DN is the distinguished name of 
the content authors group used during LDAP configuration. 

c. Save your changes and close the file.

Important: When you finish configuring your LDAP user registry, 
see "Adapting the attribute configuration" for information about 
adding and mapping attributes to ensure proper communication 
between WebSphere Portal and the LDAP server.

Note: This step is only needed if you have installed the product with 
Web Content Management and intend to use the Intranet and Internet 
Site Templates that were optionally installed with the product by 
running the configure-express task.

Important:

■ Ensure the portal administrator you specify for portal_admin_DN 
is a member of the group you specify forcontent_authors_group_
DN, otherwise the portal administrator cannot access the Web 
content libraries for the Intranet and Internet Site Templates.

■ If you plan to run the express-memberfixer task in an 
environment with multiple realms, remove 
thecn=contentauthors,o=defaultWIMFileBasedRealm group if it 
exists. If this group exists in an environment with multiple realms, 
the Member Fixer task does not have any effect.



Installing Microsoft Active Directory for Microsoft Windows 200x

8-6 JD Edwards EnterpriseOne Tools IBM WebSphere Portal for Microsoft Windows Guide

d. Run the ./ConfigEngine.sh express-memberfixer 
-DmemberfixerRealm=realm_name 
-DPortalAdminPwd=password-DWasPassword=password task, located in the 
wp_profile_root\\ConfigEngine directory.

The following table contains the value for realm_name when running the 
Member Fixer task to update the member names used by Web Content 
Management:

12. Optional: Assign access to the Web content libraries.

a. Log in as a portal administrator.

b. Navigate to Administration -> Portal Content -> Web Content Libraries.

c. Click the Set permissions icon for the Web library.

d. Click the Edit Role icon for Editor.

e. Add the group you specified for content_authors_group_DN as an Editor for 
the Intranet and Internet libraries.

f. Click Apply then Done.

g. If you have created any additional Web Content Management libraries, run the 
Web content member fixer task to update the member names used by the 
libraries.

8.1.3 LDAP User Registry over SSL
Configure IBM® WebSphere® Portal to use a standalone LDAP user registry over SSL 
to store all user account information for secure authorization. 

Perform the following steps to configure a standalone LDAP user registry over SSL: 

1. Choose one of the following options to specify the LDAP server's SSL certificate in 
either the server trust store or the default client trust store:

Note: Choose the appropriate value to enter for realm_name 
depending on the type of LDAP user registry you configured:

Type of LDAP Value

Standalone LDAP The value specified for realm_name should match 
the value forstandalone.ldap.realm in the 
wkplc.properties file.

Federated LDAP The value specified for realm_name should match 
the value forfederated.realm in the wkplc.properties 
file. If the value forfederated.realm is empty, use 
defaultWIMFileBasedRealmas the default value.

Note: Use the wp_security_xxx.properties helper file, located in the 
wp_profile_root/ConfigEngine/config/helpersdirectory, when 
performing this task to ensure the correct properties are entered. In 
the instructions below, when the step refers to thewkplc.properties 
file, you will use your wp_security_xxx.properties helper file.
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a. Choose one of the following to add the certificate to the server trust store:

The following table contains the options for adding the SSL certificate to the 
server trust store:

Option Steps

Add the certificate to the 
server trust store

1. Log in to the WebSphere Application Server 
Administrative Console.

2. Navigate to Security, SSL certificate and key 
management, SSL configurations.

3. Click the appropriate SSL configuration from 
the list. For example,

Stand-alone 
environments:NodeDefaultSSLSettings 

Clustered environments: 
CellDefaultSSLSettings

4. Click Key stores and certificates.

5. Click the appropriate trust store from the list. 
For example,

Stand-alone environments: 
NodeDefaultTrustStore 

Clustered environments: CellDefaultTrustStore

6. Click Signer certificates, click Add, and then 
enter the following information:

Type the Alias the key store uses for the signer 
certificate. 

Type the File name where the signer certificate 
is located.

7. Click OK and then click Save to save the 
changes to the master configuration.
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b. Add the certificate to the client trust store:

– See Secure installation for client signer retrieval.

– Run the retrieveSigners task from the wp_profile_root/bin directory; see 
retrieveSigners command for information. In a deployed environment, 
you will need to run the retrieveSigners task, for any federated node, 
against the Deployment Manager.

Example task: 

For stand-alone environments:

retrieveSigners.bat NodeDefaultTrustStore ClientDe-
faultTrustStore -autoAcceptBootstrapSigner -conntype 
SOAP -port port_number

For clustered environments

Retrieve the certificate from 
the port

1. Log in to the WebSphere Application Server 
Administrative Console.

2. Navigate to Security, SSL certificate and key 
management, SSL configurations.

3. Click the appropriate SSL configuration from 
the list. For example,

Stand-alone 
environments:NodeDefaultSSLSettings 

Clustered environments: 
CellDefaultSSLSettings

4. Click Key stores and certificates.

5. Click the appropriate trust store from the list. 
For example,

Stand-alone environments: 
NodeDefaultTrustStore 

Clustered environments: CellDefaultTrustStore

6. Click Signer certificates, click Retrieve from 
port, and then enter the following information:

Type the Host name used when attempting to 
retrieve the signer certificate from the SSL port. 

Type the SSL Port used when attempting to 
retrieve the signer certificate. 

Type the Alias the key store uses for the signer 
certificate. Clustered environments: Ensure the 
setting for SSL configuration for outbound 
connection matches your SSL settings.

7. Click Retrieve signer information to retrieve the 
certificate from the port.

8. Click OK and then click Save to save the 
changes to the master configuration.

Note: This task might report an error, but it does successfully update 
the trust store. You can ignore the error message. Example task: 
Stand-alone environments

Option Steps
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retrieveSigners.bat CellDefaultTrustStore ClientDe-
faultTrustStore -autoAcceptBootstrapSigner -conntype 
SOAP -port port_number 

When prompted, enter the following:

Realm/Cell Name: name 

Username: user_ID 

Password: password

The following message displays: 

CWPKI0308I: Adding signer alias "alias_name" to local keystore "Client-
DefaultTrustStore" with the following SHA digest: ssl_certificate_finger-
print

– Update the trust store properties file.

2. Use a text editor to open the wkplc.properties file, located in the wp_profile_
root\\ConfigEngine\\properties directory.

3. Required: Enter a value for the following required parameters in the 
wkplc.properties file under the VMM Stand-alone LDAP configuration heading:

standalone.ldap.id 

standalone.ldap.host 

standalone.ldap.port 

standalone.ldap.bindDN 

standalone.ldap.bindPassword 

standalone.ldap.ldapServerType 

standalone.ldap.userIdMap 

standalone.ldap.groupIdMap 

standalone.ldap.groupMemberIdMap 

standalone.ldap.userFilter 

standalone.ldap.groupFilter 

standalone.ldap.serverId 

standalone.ldap.serverPassword 

standalone.ldap.realm 

standalone.ldap.primaryAdminId 

standalone.ldap.primaryAdminPassword 

standalone.ldap.primaryPortalAdminId 

standalone.ldap.primaryPortalAdminPassword 

standalone.ldap.primaryPortalAdminGroup 

standalone.ldap.baseDN

Note: See the properties file for specific information about the 
required parameters and for advanced parameters.
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4. Required: Enter a value for the following required entity types parameters in the 
wkplc.properties file under the LDAP entity types heading:

standalone.ldap.et.group.objectClasses 

standalone.ldap.et.group.objectClassesForCreate 

standalone.ldap.et.group.searchBases 

standalone.ldap.et.personaccount.objectClasses 

standalone.ldap.et.personaccount.objectClassesForCreate 

standalone.ldap.et.personaccount.searchBases

5. Required: Enter a value for the following required group member parameters in 
the wkplc.properties file under the Group member attributes heading:

standalone.ldap.gm.groupMemberName 

standalone.ldap.gm.objectClass 

standalone.ldap.gm.scope 

standalone.ldap.gm.dummyMember

6. Required: Enter a value for the following required relative distinguished name 
(RDN®) parameters in the wkplc.properties file under the Default parent, RDN 
attribute heading:

standalone.ldap.personAccountParent 

standalone.ldap.groupParent 

standalone.ldap.personAccountRdnProperties 

standalone.ldap.groupRdnProperties

7. Enter a value for the following parameters to enable Secure Socket Layers (SSL):

Required parameters:

standalone.ldap.sslEnabled 

standalone.ldap.sslConfiguration

Optional parameters:

Note: See the properties file for specific information about the 
required parameters and for advanced parameters.

Note:  See the properties file for specific information about the 
required parameters and for advanced parameters.

Note:  See the properties file for specific information about the 
required parameters and for advanced parameters.

Note:  See the properties file for specific information about the 
required parameters and for advanced parameters.
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standalone.ldap.certificateMapMode 

standalone.ldap.certificateFilter

8. Save your changes to the wkplc.properties file.

9. Run the ./ConfigEngine.sh validate-standalone-ldap -DWasPassword=password 
task to validate your LDAP server settings.

10. Run the ./ConfigEngine.sh wp-modify-ldap-security -DWasPassword=password 
task, from thewp_profile_root\\ConfigEngine directory, to set the stand-alone 
LDAP user registry.

11. Stop and restart the appropriate servers to propagate the changes. For specific 
instructions, see the following link under Related tasks: Starting and stopping 
servers, deployment managers, and node agents.

12. Run the ./ConfigEngine.sh wp-validate-standalone-ldap-attribute-config 
-DWasPassword=password task, from the wp_profile_root\\ConfigEngine 
directory, to check that all defined attributes are available in the configured LDAP 
user registry.

8.2 Working with LDAP Attributes
This section describes how to:

■ Perform a query on attributes.

■  Add new attributes to your user registry.

■ Map attributes between WebSphere Portal and your LDAP server.

■ Remove attributes from your database.

After installing IBM® WebSphere® Portal and configuring your LDAP user registries, 
you can query the defined attributes to see what attributes are flagged as unsupported 
or if the attribute is mapped to a different LDAP attribute. 

To perform a query:

Run the ./ConfigEngine.sh wp-query-attribute-config -DWasPassword=password 
task, from thewp_profile_root/ConfigEngine directory, any time during the 
configuration process or at runtime to query an overview of the currently defined 
attributes. 

Attention: If you have not deleted the default file repository, 
WasPassword is the value entered during installation and not a value 
found in your LDAP user registry. 

Note: During the validation task, you may receive the following 
prompt: Add signer to the trust store now? Press y and then Enter.

Important: When you finish configuring your LDAP user registry, 
see "Adapting the attribute configuration" for information about 
adding and mapping attributes to ensure proper communication 
between WebSphere Portal and the LDAP server.



Working with LDAP Attributes

8-12 JD Edwards EnterpriseOne Tools IBM WebSphere Portal for Microsoft Windows Guide

This task creates the availableAttributes.html report, located in the wp_profile_
root/ConfigEngine/logdirectory. The report contains one table that lists the available 
attributes for Users (PersonAccount) and one table that lists the available attributes for 
Groups. For each configured repository, there is a column that indicates if the attribute 
is flagged as unsupported or if the attribute is mapped to a different LDAP attribute. 

The VMM is configured with a default attribute schema that might not be compatible 
with your LDAP server. If this is the case, extend the VMM attribute schema by adding 
new attributes that you can map between IBM® WebSphere® Portal and your user 
registry. 

Perform the following steps to add new attributes to your user registry:

1. Install the required Enterprise Archive (.ear) file on WebSphere Application Server.

a. Open a command prompt.

b. Navigate to the wp_profile_root\\ConfigEngine directory.

c. Run the ./ConfigEngine.sh wp-la-install-ear -DWasPassword=password task.

2. Stop and restart the appropriate servers to propagate the changes. For specific 
instructions, see the following link under Related tasks: Starting and stopping 
servers, deployment managers, and node agents.

3. Use a text editor to open the wkplc.properties file, located in the wp_profile_
root\\ConfigEngine\\properties directory.

4. Enter a value for the following required parameters in the wkplc.properties file 
under the VMM Property Extension Properties heading:

la.providerURL 

la.propertyName 

la.entityTypes 

la.dataType 

la.multiValued

5. Save your changes to the wkplc.properties file.

6. Run the ConfigEngine.sh wp-add-property -DWasPassword=password task to 
add the attribute to the user registry.

Note: This task does not validate the existence of attributes in the 
LDAP schema.

Note: See the properties file for specific information about the 
required parameters and for advanced parameters.

Note: This task performs an EJB call to WebSphere Application 
Server, which must authenticate against WebSphere Application 
Server. Depending on the configuration in the sas.client.props file, you 
may receive a popup window or a command line prompt asking for 
user identity and password. Enter the WebSphere Application Server 
user ID and password. 
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7. Stop and restart the appropriate servers to propagate the changes.

After you install and configure your LDAP user registry and after you query the 
defined attributes, you can map the attributes so they match the configured LDAP 
servers and your business needs. 

Perform the following steps to map attributes between WebSphere Portal and your 
LDAP server; if you have multiple LDAP servers, you will need to perform these steps 
for each LDAP server:

1. Use a text editor to open the wkplc.properties file, located in the wp_profile_
root\\ConfigEngine\\properties directory.

2. For a stand-alone repository, enter a value for the following sets of parameters in 
the wkplc.properties file to identify your LDAP server. The parameters are found 
under the LDAP attribute configuration heading: 

standalone.ldap.id 

standalone.ldap.host 

standalone.ldap.port 

standalone.ldap.sslEnabled 

standalone.ldap.bindDN 

standalone.ldap.bindPassword 

standalone.ldap.baseDN

3. For a stand-alone repository, run the following task from the wp_profile_
root\\ConfigEngine directory. This task checks that all defined attributes are 
available in the configured LDAP user registry:

ConfigEngine.sh wp-validate-standalone-ldap-attribute-config 
-DWasPassword=password

4. Open the ConfigTrace.log file, located in the wp_profile_
root\\ConfigEngine\\log directory, to review the following output for the 
PersonAccount and Group entity type:

The following attributes are defined in WebSphere Portal but not in the LDAP 
server

This list contains all attributes that are defined in WebSphere Portal but not 
available in the LDAP. Flag attributes that you do not plan to use in WebSphere 
Portal as unsupported. Map the attributes that you plan to use to the attributes 
that exist in the LDAP; you must also map the uid, cn, firstName, sn, 

Remember: If you have multiple properties to add, repeat all steps, 
except for the wp-la-install-ear task, until all new attributes are added.

Note: Make sure you use the same values you used to configure 
your LDAP server. 

Note: See the properties file for specific information about the 
required parameters and for advanced parameters.
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preferredLanguage, and ibm-primaryEmail attributes if they are contained in the 
list.

The following attributes are flagged as required in the LDAP server but not in 
WebSphere Portal

This list contains all attributes that are defined as "MUST" in the LDAP server but 
not as required in WebSphere Portal. You should flag these attributes as required 
within WebSphere Portal; see the step below about flagging an attribute as either 
unsupported or required.

The following attributes have a different type in WebSphere Portal and in the 
LDAP server

This list contains all attributes that WebSphere Portal might ignore because the 
data type within WebSphere Portal and within the LDAP server do not match.

5. Use a text editor to open the wkplc.properties file, located in the wp_profile_
root\\ConfigEngine\\properties directory.

6. For a stand-alone repository, enter a value for the following sets of parameters in 
the wkplc.properties file to correct any issues found in the config trace file. The 
following parameters are found under the LDAP attribute configuration heading:

standalone.ldap.id 

standalone.ldap.attributes.nonSupported 

standalone.ldap.attributes.nonSupported.delete 

standalone.ldap.attributes.mapping.ldapName 

standalone.ldap.attributes.mapping.portalName 

standalone.ldap.attributes.mapping.entityTypes

For example, the following values will flag certificate and members as 
unsupported attributes and will map ibm-primaryEmail to mail and ibm-jobTitle 
to title for both the PersonAccount andGroup entityTypes:

standalone.ldap.attributes.nonSupported=certificate, members

standalone.ldap.attributes.nonSupported.delete=

standalone.ldap.attributes.mapping.ldapName=mail, title

standalone.ldap.attributes.mapping.portalName=ibm-primaryEmail, ibm-jobTitle

standalone.ldap.attributes.mapping.entityTypes=PersonAccount, Group

7. Save your changes to the wkplc.properties file.

8. For a stand-alone repository, run the following task from the wp_profile_
root\\ConfigEngine directory. This tasks updates the LDAP user registry 
configuration with the list of unsupported attributes and the proper mapping 
between WebSphere Portal and the LDAP user registry:

./ConfigEngine.sh wp-update-standalone-ldap-attribute-config 
-DWasPassword=password

Note: See the properties file for specific information about the 
required parameters and for advanced parameters.
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9. Stop and restart the appropriate servers to propagate the changes. For specific 
instructions, see the following link under Related tasks: Starting and stopping 
servers, deployment managers, and node agents.

10. Optional: Perform the following steps to flag an attribute as either unsupported or 
required for the entire WebSphere Portal environment instead of just for the 
specified LDAP:

a. Enter a value for the following required parameters in the wkplc.properties 
file:

user.attributes.required

 user.attributes.nonsupported

b. Save your changes to the wkplc.properties file.

c. Run the following task from the wp_profile_root\\ConfigEngine directory:

./ConfigEngine.sh wp-update-attribute-config 
-DWasPassword=password

d. Stop and restart all necessary servers to propagate your changes.

Due to a Virtual Member Manager (VMM) limitation, there is currently no task to 
update an attribute. Therefore, if you added an attribute to your property extension 
database or when adapting attributes to match your LDAP server that were spelled 
incorrectly or already added due to migration, you must remove the attribute from the 
database. Use caution when performing these steps. 

Perform the following steps to remove an attribute from your database: 

1. Open the tool you use to edit your database.

2. Verify that your attribute name is available in the LAPROP table.

3. Delete the required attributes from the LAPROP table.

4. Open the wimxmlextension.xml file, located in the wp_profile_
root/config/cells/cellname/wim/model directory.

5. Locate and delete the propertySchema definition for the attributes that you 
deleted from the LAPROP table; for example:

    <wim:propertySchema nsURI="http://www.ibm.com/websphere/wim" 
dataType="String"
        multiValued="true" propertyName="attribute_name">
      
<wim:applicableEntityTypeNames>PersonAccount</wim:applicableEntityTypeNames>

Note: See the properties file for specific information about the 
required parameters and for advanced parameters.

Important: Do not remove attributes that have already been 
populated with user values because this can cause database 
inconsistencies. 

Cluster Note: In a clustered environment, perform the following 
steps on the deployment manager and then resynch the nodes.
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    </wim:propertySchema>
6. Save your changes to the wimxmlextension.xml file.

7. Open the wimconfig.xml file, located in the wp_profile_
root/config/cells/cellname/wim/config directory.

8. Locate and delete the propertiesNotSupported definitions for the attributes that 
you deleted from the LAPROP table; for example:

<config:propertiesNotSupported name="attribute_name">

9. Save your changes to the wimconfig.xml file.

10. Stop and restart the server1 and WebSphere_Portal servers from the wp_profile_
root/bin directory.

8.3 Configuring LDAP Server for Dynamic Group Queries
By default, WebSphere Portal is enabled for static groups. However, the Virtual 
Member Manager (VMM) allows users to be members of either static or dynamic 
groups. Static groups are those where a persistent binding exists between a group and 
its members. Dynamic groups are those where a search query is defined to retrieve the 
members of a group. If you have your LDAP server configured to use dynamic 
groups, complete the steps in this task for WebSphere Portal to use dynamic group 
queries when you setup your LDAP server. 

Perform the required tasks to configure either a stand-alone or federated LDAP server 
security. 

The steps in this task use groupOfURLs as the object class for dynamic groups and 
memberURL as the dynamic membership attribute. The actual values for object classes 
and dynamic membership attributes can vary depending on your LDAP server. For 
this reason, you should export an LDIF file to verify the object classes and dynamic 
membership attributes. Either refer to your LDAP documentation or ask your LDAP 
administrator for instructions on exporting an LDIF file. 

To configure WebSphere Portal to use dynamic groups, do the following:

1. For stand-alone LDAP server or federated LDAP server(s), perform these steps:

a. Navigate to the following directory: wp_profile_root/cells/cell_
name/wim/config.

b. Locate and open wimconfig.xml with any text editor.

c. Add the following line to the <config:groupConfiguration> tag:

<config:dynamicMemberAttributes name="memberurl" 
objectClass="groupofurls"/>

d. Save and close wimconfig.xml.

2. Stop and restart the appropriate servers to propagate the changes.

Clustered environments: Perform the following steps on the 
Deployment Manager then synchronize the nodes.
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8.4 Configuring a Portal to Use LDAP Referrals
Referrals redirect object requests from one LDAP server to another when objects do 
not exist or cannot be located in a particular directory tree. You should enable referrals 
if your environment has more than one user registry existing on multiple servers or 
domains. 

To configure your portal to use LDAP referrals, do the following:

1. Use any text editor to open the wkplc.properties file in the following directory: 
wp_profile_root/ConfigEngine/properties.

2. Specify values for the following parameters:

■ et.ldap.id=ID_of_your_LDAP_server

■ et.ldap.host=hostname_of_your_LDAP_server

■ et.ldap.referral=follow

3. Save and close wkplc.properties.

4. Run the following task from the wp_profile_root/ConfigEngine directory to create 
an LDAP entity type:

./ConfigEngine.bat wp-update-et-ldap -DWasPassword=password
Windows: ./ConfigEngine.sh wp-update-et-ldap -DWasPassword=password
i: ./ConfigEngine.sh wp-update-et-ldap -DWasPassword=password

5. Stop and restart the appropriate servers to propagate the changes.

8.5 Enabling Security with the LDAP Directory
Once you have enabled security with your LDAP directory, you must provide the user 
ID and password required for security authentication on WebSphere Application 
Server when you perform certain administrative tasks with WebSphere Application 
Server.

For example, to stop the WebSphere Portal application server, you would issue this 
command:

stopServer WebSphere_Portal -user admin_userid -password admin_
password

8.6 Configuring an External HTTP Server for WebSphere Portal v7.0
By default, the installation configures the WebSphere Portal v7.0 to use the internal 
HTTP transport within the WebSphere Application Server to handle requests (port 
10030). Portal also supports the use of an external Web server which is the 
recommended configuration for production Portals.

This section explains how you can configure an external web server port to 
communicate with the WebSphere Portal, which includes these tasks:

■ Creating a webserver definition for the wp_profile

■ Remapping the WebSphere portal to the external web server

■ Modifying the wpconfig.properties file

■ Adding the external port

■ Generating the webserver plugin for the wp_profile
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■ Propagating webserver plugin

8.6.1 Creating a Webserver Definition
When WebSphere Application Server was initially installed, a webserver definition 
was created for the WebSphere Application Server profile, known as the default 
profile. The installation of the WebSphere Portal Server creates a new profile, wp_
profile. This profile is a non-default profile. Non-default profiles do not have web 
server definitions or plugin files created for them at the time of install. To use an 
external http server with portal, a second webserver definition and its corresponding 
plugin-cfg.xml file must be created manually for the wp_profile.

To create the new definition:

1. Log in to the server1 admin console of the wp_profile, Navigate to servers, 
webservers, and then click New.

2. Provide the Server name and Host name and the platform, and click Next.

3. Select the IHS Template and proceed by clicking Next.



Configuring an External HTTP Server for WebSphere Portal v7.0

Configuring the Microsoft Active Directory for Portal 8-19

4. Enter details in the following screen to refer to the installation paths, and then 
click Next.

5. Review the information and click Finish.
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6. In the Web servers page click Save option. After which the following screen 
appears.

8.6.2 Adding a Virtual Host Definition
If you want to access WebSphere Portal using a host name and port different from 
your Web server default (i.e port 80), add the required virtual host definition using the 
WebSphere Application Server administrative console.

1. Select Environment, Virtual Hosts.

2. Select the default_host entry or the entry for the virtual host that is being used to 
access the WebSphere Portal application.

3. Select Host Aliases, and verify whether there is a host name and port entry 
corresponding to the values used to access WebSphere Portal (for example, 
*:10039). Select New, and enter the information for the host name and port you 
want to use. (In the example below port 81 was added.)
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4. Save your changes.

8.6.3 Generate the Web Server Plug-in for wp_profile
To use an external http port to access the portal, you must generate the plugin file with 
the new changes.

1. From the portal administration console select Servers, Web servers. Select 
webserver81 which we just created above and click the generate plugin button.

2. From the portal administration console select Servers -> Web servers. Select 
webserver81 which we just created above and click the propagate plugin button. 
Note the location of the new plugin that is displayed in the messages section when 
the generation and propagation completes.
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3. Open the httpd.conf file for editing.

4. Add a line for a Listen directive for the external port selected above. For example: 
Listen 81

5. Locate the entry in the httpd.conf file with the path to the plugin-cfg.xml file. 
Verify that the path points to the location of the file generated above. If not, change 
the path to match the file location.

WebSpherePluginConfig 
"/u01/IBM/HTTPServer/Plugins/config/wps7httpserver/plugin-cfg.xml"

6. Restart both the Web server (i.e webserver81) and the WebSphere_Portal servers.

8.7 Installing the JD Edwards Collaborative Portal
Once the Portal Server is running, you must install the Collaborative Portal, which 
provides the JD Edwards EnterpriseOne Interface and Portlet Deployment Structure.

Refer to the JD Edwards EnterpriseOne Tools IBM WebSphere Portal Reference Guide
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AStart and Stop Portal Servers

This appendix contains the following topics:

■ Section A.1, "Starting and Stopping the WebSphere Portal Administration Server 
(server1)"

■ Section A.2, "Starting server1 (Portal Administration Server)"

■ Section A.3, "Stopping server1 (Portal Administration Server)"

■ Section A.4, "Starting and Stopping the WebSphere Portal Server"

■ Section A.5, "Starting the WebSphere Portal Server"

■ Section A.6, "Stopping WebSphere Portal Server"

Beginning with Tools release 8.97, management of the application servers can be 
performed through the JD Edwards EnterpriseOne Server Manager application. This is 
the recommended method for starting, stopping and configuring application and 
portal servers. For additional information about Server Manager, refer to the Server 
Manager Guide for Tools Release 9.1, which is available on My Oracle Support.

The collaborative portal can also be managed through the WebSphere Administration 
Server and command line commands like previous releases. This remains the only 
option for JD Edwards EnterpriseOne Xe and ERP8 installations.

Refer to the following Knowledge Document E1: SVM: WebSphere 7.0.0.11 Secure 
Profile, Server Manager Unable to Detect Status of Servers Correctly (Doc ID 
1262748.1) in order for Server Manager to detect the status of WebSphere_Portal server 
correctly.

A.1 Starting and Stopping the WebSphere Portal Administration Server 
(server1)

To locate the scripts to start and stop the WebSphere Portal Administration Server 
(server1), navigate to this directory:

X:\IBM\WebSphere\AppServer\profiles\<PROFILE_NAME>\bin

Caution:  The Portal is installed with its own profile which, by 
default, is wp_profile. When starting and stopping server1 for portal 
and the WebSphere_Portal server, it is necessary to be in the wp_
profile/bin directory. Portal services cannot be managed using the 
WAS default profile from the profiles/default/bin directory.
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A.2 Starting server1 (Portal Administration Server)
From the above specified /bin directory, you can start server1 by entering this 
command:

startServer server1 -user wpsadmin -password wpsadmin

Optionally the server can be started from Windows Services applet (services.msc).

A.3 Stopping server1 (Portal Administration Server)
From the above specified /bin directory, you can stop server1 by entering this 
command:

stopServer server1 -user wpsadmin -password wpsadmin

Optionally the server can be stopped from Windows Services applet (services.msc).

A.4 Starting and Stopping the WebSphere Portal Server
To locate the scripts to start and stop the WebSphere Portal Server, navigate to this 
directory:

X:\IBM\WebSphere\AppServer\profiles\<PROFILE_NAME>\bin

A.5 Starting the WebSphere Portal Server
From the above specified /bin directory, you can start the WebSphere Portal Server by 
entering this command:

startServer WebSphere_Portal

Optionally the server can be started from Windows Services applet (services.msc).

Note: The security user credentials will not be required if you have correctly 
configured the credentials in the soap.client.props file. This is also a pre-requisite for 
Server Manager.

A.6 Stopping WebSphere Portal Server
From the above specified /bin directory, you can stop the WebSphere Portal Server by 
entering this command:

Note: The security user credentials will not be required if you have 
correctly configured the credentials in the soap.client.props file. This is 
also a pre-requisite for Server Manager.

Note: The security user credentials will not be required if you have 
correctly configured the credentials in the soap.client.props file. This is 
also a pre-requisite for Server Manager.

Note: The security user credentials will not be required if you have 
correctly configured the credentials in the soap.client.props file. This is 
also a pre-requisite for Server Manager.
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stopServer WebSphere_Portal -user wpsadmin -password wpsadmin

Optionally the server can be stopped from Windows Services applet (services.msc).

Note: The security user credentials will not be required if you have 
correctly configured the credentials in the soap.client.props file. This is 
also a pre-requisite for Server Manager.
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BExample of a PortalUsers.ldif File

This appendix provides an example of a PortalUsers.ldif file. You should edit this file 
using your company information.

version: 1
# NOTE: you must edit this file before importing it and replace all
# occurrences of the default suffix "dc=yourco,dc=com" with the suffix
# that your LDAP server is configured for.
dn: dc=denver,dc=oracle,dc=com
objectclass: domain
objectclass: top
# Add lines according to this scheme that correspond to your suffix
dc: dc=denver,dc=oracle,dc=com
 
dn: cn=users,dc=denver,dc=oracle,dc=com
objectclass: container
objectclass: top
cn: users
 
dn: cn=groups,dc=denver,dc=oracle,dc=com
objectclass: top
objectclass: container
cn: groups
 
dn: uid=wpsadmin,cn=users,dc=denver,dc=oracle,dc=com
objectclass: organizationalPerson
objectclass: person
objectclass: top
objectclass: inetOrgPerson
uid: wpsadmin
userpassword: wpsadmin
sn: admin
givenName: wps
cn: wps admin
 
dn: uid=wasadmin,cn=users,dc=denver,dc=oracle,dc=com
objectclass: organizationalPerson
objectclass: person
objectclass: top
objectclass: inetOrgPerson
uid: wasadmin
userpassword: wasadmin

Note: You can find the PortalUsers.ldif template file from the Portal 
Setup CD.
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sn: admin
givenName: was
cn: was admin
 
dn: uid=wpsbind,cn=users,dc=denver,dc=oracle,dc=com
objectclass: top
objectclass: person
objectclass: organizationalPerson
objectclass: inetOrgPerson
uid: wpsbind
userpassword: wpsbind
sn: bind
givenName: wps
cn: wps bind
 
dn: cn=wpsadmins,cn=groups,dc=denver,dc=oracle,dc=com
objectclass: groupOfUniqueNames
objectclass: top
uniquemember: uid=wpsadmin,cn=users,dc=denver,dc=oracle,dc=com
cn: wpsadmins
 
 
dn: cn=wpsContentAdministrators,cn=groups,dc=denver,dc=oracle,dc=com
objectclass: groupOfUniqueNames
objectclass: top
uniquemember: uid=wpsadmin,cn=users,dc=denver,dc=oracle,dc=com
cn: wpsContentAdministrators
 
dn: cn=wpsDocReviewer,cn=groups,dc=denver,dc=oracle,dc=com
objectclass: groupOfUniqueNames
objectclass: top
uniquemember: uid=wpsadmin,cn=users,dc=denver,dc=oracle,dc=com
cn: wpsDocReviewer
 
dn: cn=wcmadmins,cn=groups,dc=denver,dc=oracle,dc=com
objectclass: groupOfUniqueNames
objectclass: top
uniquemember: uid=wpsadmin,cn=users,dc=denver,dc=oracle,dc=com
cn: wcmadmins
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DBCA

An abbreviation for Database Configuration Assistant.

JAR file

JAR files are a Java Archive and are built based on the ZIP file format and use the .jar 
file extension. This format is typically used to combine  Java class files and associated 
metadata and resources into one file that can distribute application software or 
libraries for the Java platform.

JDBC

An abbreviation for Java Database Connectivity. The JDBC Connector is a program 
that allows different databases to be accessed by Java application servers that are run 
on the J2EE platform.

LDAP directory

LDAP is an abbreviation for Lightweight Directory Access Protocol. This directory is a 
data store for user data, such as the user ID, password, and user name. 

MTR

An abbreviation for Minimum Technical Requirements.

WAR file

A WAR file is a Web application ARchive is a JAR file used to for the distribution of 
JavaServer Pages, Java Servlets, Java classes, XML files, tag libraries and static Web 
pages that comprise a Web application.

WAS

An abbreviation for WebSphere Application Server.
Glossary-1
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